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India physical features

Geographical Set Up: India takes its standard time from
the meridian of 82 30 E, which is 5 %2 hours ahead of
Greenwich Mean time ( O longitude).Pakistan time is 5
hoursahead of GMT and Bangladeshtimeis6 hours ahead
of GMT.

Significance of Location: Barring the plateau of
Baluchistan (which form part of Pakistan), the two great
ranges of Sulaiman and Kirthar cut it off from the west.
Along the north, the great mountain wall formed by the
Hindukush, Karakoram and the Himalayas, which is diffi-
cult to cross, cuts it off from the rest of the continent.
Similarly, the southward of-shoots of the Eastern Himala-
yas separate it from Russia. The tropical monsoon climate
ofIndia, which ensures a fair supply of moisture and forms
the basis of farming in India, is also a result of its location
in the southern part of Asia. Since the opening of Suez
Canal (1867) India's distance from Europe has been
reduced by 7,000km. Itthus bridges the space between the
highly industrialized nation of the west and the semi-arid,
and south-western Asia and the most fertile and populated
regions in the south-east and far-east countries.

The Trans Himalayas or Tibetan Himalayas: The
largest glaciers are Hispar and Batura (over 57 kmlong) of
Hunza Valley and Biafo and Baltaro (60 kmlong) of Shigar
Valley. The Siachen of Nubra Valley is the longest with a
length of over 72 km.The Purvachal orthe Eastern Hills: In
the east after crossing the Cihang gorge the Himalayas
bend towards south forming a series of hills running through
Arunachal Pradesh, Nagaland, Manipur, Mizoram, Tripura
and eastern Assamand form the boundary between India
and Burma. Brahmaputrarivers divide
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Himalayas into three sections: the main Himalayas, the
northwest Himalayas and the southeast Himalayas. The
main Himalayas running from the Pamir Plateau in the
northwest to Arunachal Pradesh in the southeast are the
youngest mountainsin the world. The highest peak of the
waord, the Mount Everst (8,884m, named after Sir George
Everst). There are about 140 peaks in the Himalayas
whose elevation is more than the Mount Blanc (4,810m),
the highest peak of the Alps. The three mountain ranges:
the Himadriin the north(the greater Himalayas)the Himachal
in the middle(the lesser Himalayas) and the Siwalik (the
Outer Himalayas), facing thr palins of India. The Himadri
is of grat elevations (6,000m) which remains covered with
everlasting snows. The Siwalik have some flat-floored
structural valleys knowns as duns. Dehradun is well-
known. Between the Himadri and the Himachal are some
broad synclincal valleys. We also classify them as Punjab
Himalayas, Kumayun, Assam Nepal and Northern.

Significance of Himalayas: (i) Physical Barriers (ii)
Birthplace of Rivers (iii) Influence on climate (iv) Floraand
Fauna (v) Mineral Resources (vi) Economic Resources (vii)
Tourist

The Great Northern Plains: Lies between the great
Himalayasin the North and the plateau of PeninsularIndia
in the south. Nearly 2400 km long around 250-320 km
broad, the most extensive plan indeed. It is said that this
regionwas once avastdepression, filled with silt- brought
down by the three Himalayas River, namely the Indus, the
Ganga and the Brahmaputra and their numerous tributar-
ies. It contains some of the richest soils. The bhangar
refers to the upland formed by deposition of olderalluvium
in the river beds and the Khadar are lowlands formed by
deposition of detritus of new alluvium in the river beds.



Bhabar and Terai: Includes those regions where the
Himalayas and other hilly regions join the plains. Coarse
sand and pebbles are deposited. Bhabar lands are nar-
rower in the east and extensive in the western and north-
western hilly. Water converts large areas along the river
into swamps known as Terai.

The Western or Rajasthan Plains: are known as
Marusthali of Thar and the adjoining Bagar areas to the
west of Aravalli. Luni whose water is sweet in the upper
reaches and saltish by the time is reaches the sea. The
several salt lakes in the region such as the Sambhar,
Degana, Kuchaman and Didwana; fromwhich table saltis
obtained. In most of the region shifting sand dunes occur.

The Punjab-Haryana Plain: These plains owe their
formation to the Sutlej, the Beas and the Ravirivers. Many
low lying flood plains (called bets) are found here. The Bari
Doab between Raviand Beasrivers, the Bist Doab between
the Beas and Sutlejand the Malwa plain are relatively more
fertile plain.

The Ganga Plain: The Ganga-Yamuna Doab comprising
the Rohilkhand and the Avadh Plain is the tile area that is
drained by the tributaries of Ganga.

The North Bengal Plains: the Plains extending from the
foot of Eastern Himalayas to the northern limb of Bengal
basin cover an area of 23,000km?.

Brahmaputra Plains: Thisis alow level plain, rarely more
than 80km broad, surround by High Mountain on all sides
except on the west.

Significance ofthe GreatPlains: Riverine region, Fertile
soil, favorable climate, flat surface, constructions of roads,
extensive system of irrigation.

The Peninsular Plateau: oldest structure of the Indian
subcontinent whose slow and steady movement towards
north and north-east has been responsible for creation of
the Himalayas and the Northern Plains in place of the
Tethys seaofgeological time. Itis marked of fromthe Indo-
Gangetic plain by the mountain and hillranges such as the
Vindhyas, the satpura, and Mahadeo, Maikal, and Sarguja
ranges with the average height is usually divided into two
major subdivisions with the Narmada valley as the line of
demarcation. The region north of the Narmada valley is
known as the Central Highlands and in south of the
Narmada valley lies the Deccan Plateau.

The Central Highlands: Old Aravalli Mountain on the
west and the Vindhyas on the south. This region slopes
northward to the Ganga plains. The western part of the
Central highlands is known as the Malwa Plateau. The
Central part has a number of small plateaus like those of
Rewa, Baghelkhand and Bundlekhand. The eastern part of
the Central Highlands comprises the Chotanagpur plateau.

The Deccan Plateau: The Deccan Plateau extends from
the vindhyas to the southern tip of the Peninsula. This
triangle plateau is at its widest in the north. The Vindhya
Range and its eastern extension namely Mahadev hills
Kaimuir Hills and Maikal Range from its northern edge.
Western Ghats are known by different regional names

such as the Sahyadris in Maharastra and Karnataka, the
niligris in TamilNadu and Annamalaiand the Cardamon hill
alongthe Keralaand Tamilnaduborder. The elevation ofthe
ghats increases towards the south. The highest peak,
Anaimudi (2,695 m) is in Kerala. The mostimportant gap
in the Western Ghats is the Palghat gap which links Tamil
Nadu with Kerala. The Bhorghatand the Thalghatare other
gaps lying in Maharastra state.

Eastern Ghats: These hills rise steeply from the
Coromandel coastal plain. The Eastern Ghats are well
developedinthe region between the Godavariand Mahanadi
rivers. The Eastern Ghats and Western Ghats convergein
the Nilgiri hills. Dodda Betta (2,637 m) is the highest peak
in the Nilgiri hills.

Significance of Peninsular Plateau: (i) Geological rich-
ness (ii) Sources of Irrigation and hydroelectricity (iii)
Agricultural Resources (iv) Forest Resources (v) Rich
Fauna (vi) Cultural Influences.

The coastal plains and islands

The Coastal plains: The Peninsular plateau is bounded by
coastal plains on the east and west. There is wide
difference between the eastern and western coastal plain.
The west coastis narrowerbutwet. Eastcoast much wider
butrelatively dry. Anumberofriverdeltas occuron the east
coast. The deltas of east coast fromthe 'granary’ of the five
southern states- Andhra Pradesh, Tamil Nadu, Karnataka,
Keralaand Pondicherry. The western coastal strips which
have a large number of lagoons and back waters on other
hand are noted for spices, areca nuts, coconuts palms etc.
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F |
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e T fFaw w1 |
3 e ) fFos w3 o fove & =Ifed 5a @ s &1 |
4 OK 1 fae & |
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) fFas w9 |
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fFa® FY Td ®ie T AT YA oF &l dfd g
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R fFas e (R dige wRas o1 v e ) fFos
) |

6 fore & wa% @Y 9T WiGET ®EA & I T F o,
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= oo

Eiw 3

Jole Five, TTIA, AT, OT, JELATIT ©TEd, HELATET Heol UF Uhiged § TRad FeT & |
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14 9, AATEHE F T4 T & ford, I wve, BT a7 WL,
FATECHE & A= |

w4 - 6 : T A Al e
1 Fig 1 ® fREmar s 9w deise O a1 &t fads &2 |
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S[\,’Ieﬂ v Cleardll
Task 2; Change the spacing between characters ‘ : bl
Task 2: Change the spacing between characters oty 1
Expanded o Condensed Newtiagng bl
Hewi Faagragh Headng T PUICEH O
Sclecting Evpanded or Condensed lters the spacing befween gl elected leters I - —_ Hew Paragagh Hepding §
1 Ing Expan IF LONQeNsed alfers Ny i i
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Se\ecrlhelemuchange. paing ; i the spa  upal Ho Spacing 1
Hesdng 1 a Select the tentto change Heading !
e ik the Font Dial T, and then clck the A b, ] 1l
Ot 1, ol gt s o A it o 1, O the Home tab, clickthe Font Dialog Box Launcher, and then click the Advanced tab. Hehy 2
Heading 1 fi Heading 3 ]
’, ' ! MR 1 THi fl
Calir Bod T ]| Tile i} ity AP raEy e f
VT Sublle i Subttle n
BLY o e 'A' Cublla Frabad ]

15 “Numbering and Bullets” Sa@TT a3 & I& a¥%® A=
F= & “Define New Number Format” a2« fara &3 |

16 S@TT araw fe@mg 9= Y Fig 10 & faswer =T qo
afeafia ear e 9=

17 Define New Number Format, Numbering and Bullets £t
AT TRt ® ‘OK’ dieq T¥ fas ¥ i wrfdT & @
=Ed A |

18 o1sft wrge e, =g Tl ® “New Numbering” =T
wrEa faE o= @i esEgae # o aRafda swm |
Fig 11 &7 Tga<or &2 |

Modify Style TI@mT STRT ® U WA H1 A=Al FIARE
FO  (Modify a style manually in the Modify Style
dialog box)

AT WEA AL § I3 T HTe H(AA FX Tl ©, STHIAC
| e &7 I o fomr |

1 Home tab &% #37, @iga A< ¥ FiE TEA & T
faer F<T 3w Modify e #21 | (Fig 12)

2 Formatting ST §, oq wEfeT & &g off afkada #¥
a1 g2 | (Fig 13)
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3 g & Aot aRada adwe gwdEs & forar ar wiqwr &
a9 STRgHel T @] BT @ | (Fig 14)

Fig 14

Add to the Styles gallery
@ Only in this document O New documents based on this template

FTH - 2 : IAT F AT TFE F AIA 3
1 Huome — Replace &1 =37 &3t |

2 Find what & Sachin =7 %2t s{i¥ Fig 1 % S Replace
with & Little Master Sachin =T #31 |

Fig 1
Find and Replace

Find | Replace | GoTo

|9l

Fig 12 Fig 13
Modify Style ? X
el UpdteNomel oMot Seleion AaB AaBOCeD AoBbCcDd AoBhCeDd AABBCCD Propertis
04 oy, L The Sk Siebn. Enphst ienet, i —
Style type: Paragraph
Sec AL o Dt Stles Style based on: (no style)
Rename., Style for following paragraph: | T Normal V_
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CaibriBoc) V|11 v|| B T U Adtomatic |
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=S = = E|= = =z |12 | € E
= = = = = = ¢=| £ 2E

& et |

Fig 2 ® st S|T Sachin #1 Little Master Sachin

4 'OK' 9T s 3 |

Fig 2

Find and Replace

(2] & [

Find Replace guTul

Find what:

s

Replace with:  Little Master Sachin

More »»

[ Rerface HReplacegllHEmdNext” cancel |

[

Find what:
Options:

‘Sachin

Search Down

Replace with:  Littie Master Sachin

|

5

El

[ Replce | [ Replceal | [ Fndnewt | [ cose |

Microsoft Office Word

=

@ Word has completed its search of the document and has made 6 replacements,

3 Replace All 9 fF® #3T |
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FEd. & sEfr o, (IT & ITES) s 1.6.32A
Far (COPA) - a8 maRnr ameasw
Faa # A F% wHe w0 (Insert and format the table)
IR TM AWM & o § AT FIA § q9H 81 G
o I F BHS FIAT
o IFE F I A T 39 B RS § qE |
JawEFae (Requirements)
HIFATL[STHTOT [T
e us gfard PC favet stium war MS sitftem @fea - 1 No.
afwar (PROCEDURE)
w4 - 1 : UF A TS FA
fafr 1 (Method 1) Fig 2
1 Insert tab > Table & =T | Insert Table ? >
2 fire ¥ FUX FET TATH AT0F AT AT ATE B AT A e s . _
Number of columns: 6 =
il Fom | . Mumber of rows: =] =
3 TER MY W 9T A F 9% U F FIX L Fw FAw AutoFit behavior
w0 | Fig 1 fom # 9o & feamg 9= | (®) Fixed column width:  Auto —

Fig 1
@HYD:-
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS
B CoverPage~ D E I—-‘ [ , ) SmartArt & Store W
[) Blank Page == SV ) Chant
- P Bk Tafm: Pictures P(IJ;:T:S Sha'pes L semanatiats & My apps - Wikipedial
Pages 6x6 Table ” Add-ins
= N | B .
) 1 DO00
| I
| N/
L1 | B
EEEE RN IR
N
B Insert Table..
E‘f Draw Table
1 Eﬁ; Excel Spreadsheet

] Quick Tables »

fafr 2 (Method 2)
5 Insert tab > Table > Insert Table 9% &% #=2 |

6 Fig 2 ®T 3@l 3 $0d SN a9 | WY HIH 6 AT
TET ATE I 6 FT g g7 Hrore | (Fig 2)

OK faets &1 | faw Fig 3 f&ra &1 fammanm |
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() AutoFit to contents
() AutoFit to window

[[] rRemember dimensions for new tables

I OK | Cancel

Fig 3

fafir 3 (Method 3)

1 Insert tab > Table > Draw Table 7% &+ &3t | #6¥ &
# offrer 71 S R w= |

2 O & &TE 1Y A1E a¥E HEL B ST F 2 Giwet B S|
IS0 A ATHIY |

3 O H Hrer Y GfasT e I w3 % forg St var
gt |



IR Ft 3T | T FA AT oA wt FHE F4 (Type the text into the table and format the table)

1 @& HcH 6 F AT T8¢ I 6 § dacT & 30¢ w4t |
2 FHHT Hf daT BT FUL S ALE FEL HF @l |

3 “Sl. No.” ¢R< FI 25T FT |
4

FarE | Tab key FATST ST HAH # 18T FA & forg |
A A | % @ TRe XA & a18 Tab key @@/ | ga<r &
# fill the text % forg =i gt ave |

5 Fig 4 =t 3@t 3T doRe H 28T 2 |

FE - 2 : ITA BHS HLAT
R A B GHE FeA & fordt e wrdew (Sifer) @ s

#¥ | (Use table styles to format an entire table)
1 g & I F |
2 9 A F A=Y, e aq W faasw # |

3 39 &R YT | | 9 1 =3 g7 | Fig 5 3% wd arer
F |

Fig5
ML [} 1 TN I ST
= el d [
ST Kavwu e Praclod |50 Theop® ayphrubidy  Tolad (24
Tidnae Tk Fiarts) Al =0 Kaiksi
e

T Stgm 7 g™ (Add or Remove Borders)

¥ witeAT (Add Borders)

1 T T & A/, AN ¢ T s 2 |

2 TAode Feq UX {Fa® w2, I FHT 9GT FY |

3 T T & s, fevme @ o s w7 |

4 FET YT § qEH qeA F FA9 F 0 1% pt. “ATSeEEL
ared” (Outside borders) I+ |

5 FEX g9 |, ATEF d< deq X faas #X ud #t g4 | Fig 6
3 |

Fig 4
WELWIUT  UBEENCE WLBED WA WDW DESCH | LwodT
| EEeE  REARS ARAAE SEIRTLIIICT Ty Bl — Bzl B
Trphic - R LRRE o
i W
|
e fameglite | Frotod {120 Treonn3d | Emacpebity  Toll oo |
Treires i ek Kdm fn 55 %]
Elade)
[ |
| !
I {
i I
Fig6
EL LR KA 1
m Ll
......................... ] Fare Faid; Ecve
Tl - L P Biiran
..... R IR
b
il Jord!
IghEs
arenie
BB
R THitee e | fodcarlm | Trocy B0 | Srpicgbiiy |To s =
| T e | W3tk ik Matk®)
WEa) W Frerer | e

e sTEd geT (Remove the Table Borders)
1 ¢Fa & =aT FY |

2 feomEq 3@ ) faws w3k, ared ded 94 |

3 A AT gH |

Fa # Af¥w shgwr T gern (Add or Remove shading in
a table)

=« ® it stigwt (Add shading to a table)

1 o IX oo &3¢, 39 &7 999 FA & o, a9 Fu
At FET 9T Fa qT 20 W fawE FE |

2 39 g R ¢ § AL ded W fFas w1 |

3 ot 7 & =T, S AR FAX AT AT FIAT AR €,
IFFT T FX Fig 7 39 wF 91+ #3 |

FE A, & 3 H.Lum. . Far (NSQF @2 - 4) - 394 1.6.32A 133



Tt (Row)
e |1 < e 3 ek A e R A e e
{ndn "_ A @ Ud <ad # 3o fAfire O d% = & w7 |
— ' - 2 ¥ g F AT FAeSE dad T FAE A |
'.,I.I_.i,.'.."“' 3 da s aer T e A | e s g
U . ol a It Shi IY R & |
S I e 4 < e P % Pifore avde ($E) e A |
5 0.36 &9 @19 @7 #X | Fig 9 3@ ud qrei ¥ |
Fig 9
9@ & ff¥w gemr (Remove shading from a table) i rox |
Ty o e L e
il FT 9T T qT E=A T FoAF HY | A soestybeant 150 H s ettt e TR
2 Eww g fRomet 29 A T ) o A A R R
Iqw M9t # A< FY (Set Table properties) B
3=« (Table)
1 g FT I Y |
2 9 TH & AR AAIE 2 T {Fah wY |
3 “Iad MU e IR faas w2 | “Iqd MUes e [ or || | cance
TR S IT AT AT |

4 ¥ ¥ R A wE, AR e 7, R R a 6 ‘¥ e T e FY | aaelt g U A S whi u) et

fe8aer #T &, G AT T FI9 FL UF a0 I HF «ft | Fig 10<< |
T H | Fig 10
. , . . il o Mamacftie | Practical |10 | Theowy(30. | Evployatiley | Toal jio0
5 ‘ot FeT ¥ fFew | cﬁ: O F AT H ] & Triinge Mk Marks) Wil |50 . Marks)
ST | (Fig 8) ) Marky)
Fig 8
Tiablss Brreppe s 0 [
Table | mpw | Gokn | oed |
% |1 % é |;|:1-?:Ien|:1'ru\-1!el‘|:._
rnauﬁ::p.'q el g ﬂﬁ?’lﬂ (COIUmnS)
E E_Eli 1 &T| & 999 F | FEY 9 & FUR o T, e ()
T FIAT F T FA & ford A W fFas w2 a1 wHfaE
HIAAT HT 99 F & ford Y fafvre #fcw & ad & g
Bt thers and Shading Lxpbons | @T}r &1 =T 31—1' l
[ ][ e ] 2 A TH & AR, AATIC o I faersh ¢ |
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3 ‘e Y ded R fahew F | ‘et UL SHAAnT avad
B 9% TEfid &t S |

4 Fiowg g ) fFes 7, e fagy auw ag #t [ad w1
Td 0.5 39 AT €37 FY |

5 AFE FaH ged T fFas &, e fagg F A a1 1.5 39
FI

6 ARE HiaW ded T fFds F¥, o0 3 Hiew A ke fagy
1 &9 #X ud iy Ftew #t 1.3 39 FY |

7 Ok e U fFas &%, 99 daatemaat sar Fig 11 fIard
&l

Fig 11

ae o the Traaee | FraciA 00| THeonw AT R LE
Re. Faks Wsks] il

a1y | Tread 0 Waecbs|

[
-

e, A a1 *HieH AT (Add a cell, row, or column)
A« s (Add a cell)

1 A 38 FA F ford, 37 8 W el 3 o §9¢ H3T, a1k
4 F e a¥% AT F9T & |

2 AT F F<Y, WM A@ W Rows & Columns
TEAAT Ft AT T R w |

3 ¥ ¥ UF W faew &

foree @< w1ze (Shift cells right)

TE A SIS AT & TF A /A & (390 A ) T awE free

FLIATE |

AT - zA fawer # Ot & s e Tt ar & e

Aed |

forwe &= Tew (Shift cells down)

AT T FLH, AT AT A F UF O A9 e F¢ Sar @
(39 FfeW) F | Tq@ H UF A% U UL & Al & AN I8
AT @ & a1 gt @ | the bottom of the table to
contain the last existing cell.

T It ¢ FA0 (Insert entire row)

S @« T e e fhar @ 9Es S FuY O & gl
FEAT

9RT Hiew 8E w0 (Insert entire column)
o Ftew o s fFag feem & Sa% gt avw Ftew
Fad FEAT|

3t SiteAT (Add a row)

1 UF O 9¥ el &Y SIF T8t AT U STreqr =91e @ € 3a%
e = a1 Srw FuT B |

2 A TH F TR AANE o7 W fFw W |
3 fadags m & !

S & 9¥ erw e o @ i SEs I O & st
% fort, T\ UvE Hew I § S gaa X fFw w1 |

o & X e s e @) 3w sas A O # Stre
& ford, T TR Fterw T¥ I9 | o foe ¥ R w1 |

HiwH AT (Add a column)

1 OF @ I¢ el H¢ S ST&l 3T Hhidq SreqT =97e ® &
F I+ T a7 9 T & |

2 W T F AR AATSE 3 W fawd |
3 W A TF F
5 3 T 9 e BT @ S St avw diaw stied
# ford, T| UT *e g0 § 3\ dw X fFE w1 |
5 A o e e R @ IS gy avw #iaw sted
* ford, T Wt Few YT F AT T MEE X fFer ¥ |
I, T 71 wiew ¥ g (Delete a cell, row, or column)
1 f=fofaad & 8 T #< ;

A cell Aqd & ad Y ox fFos & ,::::r
Arow T F IET AT fFw w1 A8 |: ||:::

A column Hie¥ &t FIET 3T a1 9T FreerzT 1< s
. !

+]
2]

|

2 A TH F AR, AN T T {FA® F |

3 O &iew Y7 7, feche o fFos w1 38+ ag feehe &,
feeliT oiw a1 fechie wtemm fFas & ot sfa o |
e wt 7t (Fremn) ar fEfee (Rrws=) #3=1 (Merge or

split cells)

A @ (Merge cells)

1 I AA FT 999 L o= AT A1 HAT 90ed &, & & I
for wx faers #3% gy Al a% @i F F qE A=l a®
AT FeAt Ht T =med 2 |
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2 WA TH F AR, ANSE ¢F T ASA IT § A qed T
IEGERETY

wrfere @< (Split cells)

1 &a ¥ fFa® FY AT THIAE AT FT 999 FL o8 3T
fararfora #eaT =med € |

2 A T H, AATIE T X, AA T & 72T Wiore o T
s # |

3 I = & F fhaa Ow A wtew & Al #Ar
T & IAH TE&AT 3 FY |

aq | I F J@Ea w0 (Align Text in a Table)

1 2R (A8 F arelr) T & T8 #W |

2 9 TH & AR AATIE ¢F & 947 X UF AATZHT IT |
“STeATE SveY #1999 #< | Fig 12 # 39 ud 91+ #¢ |

Fig 12

= _ = .' :"'

- — ‘58

ripute Columns r—_l = feod Call
= I Direction Margins

H:"

rinute Rows [ |

Aligrnment

& B )

3 = Fig 13 ST fars & |

Fig 13
: - o Epmpiy
i Yame i e Tranes T [ Shis[s0 | Tobd 2Mefks
He. LS| Wik mlli'- :

4 TfF AATEAAT FIA FT A F AF - (AT 2T 9L,
Y T Fiey WEC |
¥ga # ¥ & e (sReEe) FgewT (Change the Text

Direction in a Table)

1 T 89 &1 93w # |

2 A T | AT AATSC e TN [FF F U HAAgAHe Iq
H ‘Toe TR IX 9a-fada® #¥ Fig 14 3@ U4 91
Exd

Fig 14
5 T L R - N i R 1]
] | . - M T
PR S Mesnm = Al b I I'I" M
x B _”1‘ | H i .71 R LT B B T TR (¥ g |
Irmt i el ¥ T e TR o
tde Tk o+ E 2 et fragen
g o il T
1 1 B M '
Sa
bl o ] eyl | SRR L
Y Harreul 1o Teaaes Wi kel EEEE- o ld |00 an by
e

A F AAETAREHAT T FAT (FH F S900)(Sort a list

Alphabetically)

1 29 991 TF IH 99 & ®ide w A9 Fig 15§ Famaw w&w
=

Fig 15

:_1 Hura of i Trarmn 1:1“1; ":':_th gri E_; | Todali b Mutai
1| katlaie hil1 a ]
i | Nt s = ]
= | Bw v 4 &
ke nu e L
5| ahe 13 o S

2 HAH F IR T TIT F AW AF g gfAw |

3 39A TH | ATHY, AATIC ¢F I F<, @I qeq T fFea ¢ |
(Fig 16)

Fig 16

EE |2 T | aasbcede

e _ . - .
- = = = =" ¥« " T Mormal

Faragragh

4 &Y TR A9 |, qC FL AIC AT ¢ IATH U e |
5 AT (Z to A) 7% fFF % | Fig 17 38 ud a1ed F7¢ |

6 =it o fFas F2 | sEfy #9 & Ate fFar gar o var
fewrg 2w | (Fig 18)
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Fig 17 Fig 19

Sait ? = E
42 =
it sh. = Practical (120 | Theory (30 o d
ot ey = No. | Name of the Trainee Saria] Taaka) gg‘ 2 E Tatal (200 Marks)
Calamn 2 ! THpE 1ot s DL dscenidin &=
i Descending
Usng:  Faragraphs e 2 rreerEng 5 | sed st n G
Ehien by 3 | Rant 117 2 47
Fipe et o] @) Rsgering 4 | o 3 s el
Uit [Fiagraates = [ Deiterding 2 | Kavitha 115 25 35
e Ly 1 | Karthika 18 28 a4
I EriIr I
P Pm—— Destardin
Wy it has
) Header pow ) N header o Fig 20
Optsent.. [Coe ]| conm Insert Function =]
Search for a function:
.1:\.'pe a. brie\I‘. Héscrip-ﬁ.on o-f-'A'ha.;c you 'x.'an-t";co.t-:lo and ﬁ.w.en dlék [ Go
e |
Flg 18 Or select a category: EMost Recently Used E:l
s Select a function:
aw T
il ; Pracoed 120 | Theon (30 | §E ¢ # AVERAGE E
| e of e Tvenze ) I _L':' %,ﬁ EE | retal [0 Marks] F -
ki Ieacks| Marks) S -, - HYPERLIMK.
- COUNT
Max
3 % 18 1] T SIN x
SUM{numberi,number2,...)
3 | Renl i iy it 7] Adds all the numbers in‘a range of cells,
1 | i e 4 E]
1 | kaatha 1t i #
Helo on this function [ oK ] [ Cancel
L | Kardhdca 11E I8 4
g § HeT STt (Apply formula to the Table) _
Fig 21
1 3o | & et &1 =949 FL | Fig 19 3@ 7 IFa&T 9709 #< | 5
12 -
o . . sl Practical (120 |  Theary (30 EZ2a ¥
2 39 o8 | AATSE o O faerh Y Ud BT ded 9 fRaw No, | NameoftheTainee | )| Cvuny | B33 | Toulaoomars)

F | T T BT SEACT At & 87 A | 5 | sem 13 ao 0

. . . 3 Rani 117 22 47

3 ‘:BTx’i?'lT 39 ® “=SUM (LEFT)” ez #¥ | Fig 20 3@ 7 G o P =
IHFT qTeAT FY | 2 | Kavitha 1s 5 35

1 | Karthika 118 8 a2

4 ‘OK eq 9X T #¢ |
5 I % AW F4d 8« § g8 9 | Fig 21 39 |
6 ardt & A F  FRAT FT T F

F 3 : IR F IqA F A Bl TRE | AT |

S T ST AT ST I SoRe § TG o fordd | BTH 2 T M [BTET Fig 1
e foee o faers #X arfE o 3w 9 i etagda § dae W de- u-,|:-

FH AT & W& | (Fig 1) Home Insi  Review Wiew

¥Re wt d9d § g (Convert text to a table) “3 % cut

1
=l

1 Y FFeH —S) HAE AT T — TES HY Sf I8 hoain jFormat painter |

-

AT Rt & S A Ao & i w2 | Clpboara PR

e - AR AT TRE § FAE § AT AT IR I
#, I FT ITFAT F |

AEA. & Ard A Z.uw. : w1 (NSQF TR - 4) - 30 1.6.32A 137



2 wEmE e &1 ST #1, e ge gar s e
Fel A4y a9 O Y& Y ® € | 39 IS |/, TH uH
R e 3 @t TF 2 O & UF dA H aqra |
(Fig2)

Fig 2

Red yeliow —+ blue green —» orange -purpleq

rad,yellow == blue -gresn == orange pumples

3 o IR AT 9T 9T8d & adol |, 39 HT 999 FL T
A § AT > a9 W faed F ud > FAS TRe g A
(click Insert > Table > Convert Text to Table) o¥ &=
# | (Fig 3)

Fig 3
Home Insert Design Layout Re
. =1 =1

k Page Table Pictures Online Shapes $r
e Break r Pictures v

Insert Table

]

Insert Table..,

™ Draw Table

Convert Text to Talgle..,

1| s

Eicel Spreadsheet

-
=]

FE L ¢ oa arad |, fawent & w9 # | (Fig 4)

5 I« A3 & A=Y, AT FL {F T8 T Haw g A
#t der | fae () & |

6 wtelfre fRfaaw & smw, 99 o7 oo aaet & 9 T
qMed & | 9 @d: & a9 Few Y A g o | Al
s fafee Ffew fagy =red € @ 9 & uF sfter
(forme) gferr

Fig 4

Convert Text to Table ™ e
Takliz sisc

[ CRETTT T e e DRI TS T

TR e

Sl Fil Lclrawiee

(D e oo e nnrs g ot e P

Ik

T Al il Lo corribaribe
S e @ R Faw e B e
Suprarabe bexl ak

. FaAraaranns 2 S OTImas

TE WA & ford 7E fawer g+

A HlW & AL foraee #iow fagy ataw
Fam & fort #, TET F AT A g |
B FIH FI TS I ASTE & | ATSIhe g Fred

FgA 39 ¥ fhe F F o,

AT F ATHE & qFe % ford

SUeE B # ASTE & few | sitelfwe g fast
¥ 3T FT =d: & ATHR Tao
% fordr (SgmRTer & forg, A=
KEISCRICEZ
U= % ford)

7 AT IR UE F FA=L, S UL FACT AT IR H

IUIATT FHIAT 9€ W & 7 99 |

8 M oY fFas wY | IR AT 3 /"ol | a2 ug few|

(Fig 5)

Fig 5

Aed, wellow | blue green | arange, purple
Red, vellow | blue, green | orange. purple

9 &t ¥R § qg@A1(Convert a table to text)

Gt T TRS | dead & o TS a7 a9 FT 997 F9 |

A T H, AASE ¢F T, FAC ¢ e X faead ¢ |
(Fig 6)

FAE T IHRT AT W, ANE e I & 9= 39 e
FreY O et ®Y ST AT Hiew aISvSieT § ITAT §
AT FTed € | O IR e gy sten & S |

OK 9% fera &9 |

P} - - — = i L
Ii-h E || Haghk HIEE 'Iﬁ'—_q' | Hl« Fl= 1
= BEEE — & Z =
Autaft Hiwidine| Ane | = Ter  Ce Sot Repeat [Comer
v HEE Direcber Wangia Hescler R o Tead
Aligrinei, L
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A & sEaim. (IT & ITES)
w1 (COPA) - ¢ safi stweae

e 1.6.32B

3 A sARed F g0 (afFfem) vd wie w3t (Insert and format the table and objects)

TG T AWM & AA H AT FIA H & B S0

o wze fRaaend, e dad wen ud e w9 g faswedt ® Swm wwen

o % Wk U gae Faet @ gEwE weAn
o g% ATE WIEA T A TqE FHIAT
o M7 FY F TAC FIAT, FIHT HIAT T THS FLAT |

smawwa (Requirements)

AT STHTOT/ATEA

* uF "fold PC MS =tifeser 2007 ud favet OS % &m - 1 No.

s (PROCEDURE)

FE - 1 : wrzw, fFawste, Ry 3o s ue e & g fafve et & s s == -

w1 Za¢ e (Insert a file)

1 AT STHAE SO (SreAT) wAT |

2 Z6d 3T WX fFs FY, T IU & A<, ATGeiFe A aed A1
3T U¥ fF® FY 3% 918 RS BN FEA H AAT FE |

3 T UX 8¢ wiEd e atad Wefia en |
4 faeft faftre sore & wEe IAHT IEEA 999 HY |

5 OKaed T e ¥ | T Fret T4 STRgAw< | §7¢ 8 o |
(Fig1)

Fig 1

A AZE |&% Signature Line ~ n !

E) Date & Time

uick WordArt Drop < :
arts ~ - Cap ~ ! "9 Objedl"_
Text | »gd Object...

|- =y TextfromFile.. = 7

i|||.hs.|.!

Equation Sy

Symbol:

TE # fFaaene g\ w30 (Insert a clipart into word)

1 REvT A& TH Insert-> ClipArt faser &7 =2 #3 99 § gurran
T & | (Fig 2)
fFaee averus ® @ fawew Fig 3 &

2 "UgHE" erEy X o SE g e fFer e wefia s |
(Fig 4)

3 39 fFAT AT &7 TAF FL AT AT STHAR H FHE FEAT AT8A
| (Fig 5)

Fig 2
Insert Page Layout References Mailings Reviev
3| bl (B3P 3 a
) B HEsY P M e
e Table = Picture| Clip |Shapes SmartArt Chart Screenshot
3k v _Art_ - -
Tables lllustrations
Fig3
Clip Art v X
Search for:
Results should be: B
All media file types -
[ Indude Office.com content
=
4 TEGHT F 49 &Y |

TE TTRGA A feew 8¢ w0 (Insert a picture into word

document)

1 737 O o % o g9 Ootes a¥ s #Y |

2 T4 8¢ -> e et soo 29 7 & ud &t foew dud

FIAT & 39 99 | (Fig 6) 139



Fig 4

Clip Art v x
Search for:
|education [ Go
Results should be:
All media file types -
["] Indude Office.com content =
1=

(&

Fig 5

Fig 6

Insert Page Layout References Mailings

B=1CCEEY
le Table | Picture Clip Shapes SmartArt Chart Scri
ak A Art v

Tables lllustrations

3. fUeae arge & A -> 8w Uy ™ fFs w7 | @\
e eTagHe | €0¢ of SRl | s (Desert.jpg) (Fig 7)

4 fFET T 7 & -> Fvwerw qrer g4 | (Fig 8)

Fig 7

Fig 8

ome Insert Referances Mailings R

Compress Pictures .
CFER — (s
hange Picture -‘ o
Corremons Color  Artistic =
Effects = @Ruetpdure'

Fage I.a)rout

Sharpen and Soften
" PE——— — —— — —

Brightness and Contrast

-E—ﬂm
EBEdEds

&y Picture Corrections Options...

Iuereet farsreat # frae it agenw (IWF) Ud wgme #
T FX A a0

5 e afeTw #x & ford Fere faswes &1 === F¥ | (Fig 9)

Iqare faspent d e & #oe et wd digwe #t
FHAAG FY TF AW F

6 emfefees uhaen famer #1 gAH, TS &1 Afa Srelt @ o
Fig 10. & samm T@T & |
7 @ef ¥ Rt wizer A &7 F¢ | (Fig 11)

TR A e #t aard w2 (Qny FAr) S Fig 12 #/
gwET AT e | (Apply a picture into the document as in
Fig 12)

1 SEgHw ¥ ey & 39 F 99 Fig 12 § qorim @ & |

140 JE. &, & wE A E.uw. : Far (NSQF @R - 4) - 31 1.6.32B



Fig 9

FoyE LayuuL nEEIEnLE gy renew viEw

‘ICpmpl:u Pictures = — — e :
g @ ¥ Change Picture ‘— el d} ; ;

ed;nm Calior | Artistic
1= Etfects ~ jRe;eleure
. Color Saturation |
= I [ |. P— P— :
Color Tone

ol - . o M | | — o Bl . - |

B B i el e Rl el
e i i
-.---E-'

i More Variations
@ SetTransparent Color
By Picture Color Options...

Fig 12
wyout Refererses Mailings PRieview View Farmat

H compressPictures |

Iy Change Picture ] d ‘ “ “‘ ; m

:
- g Reset Piure -

Fig 10

me Insert Page Layout References Mallings Review View
‘i Compress Pictures

m I} Change Picture

orrccllons Color
Eﬂ'edi - j Reset Picture =

%y, Artistic Effects Options...

2 e HH A & ford Hew %W fawer &1 99T w1 | (Fig 13)

Fig 13

ehdweBoderr] |'¥ wm snmEn
+ | Theme coons .

Fig 11
1 e e e o
eﬂ4 ﬁ j;(cumpresspmures = —| —_— — =
Change Pict : ‘
: Curremuns Calor Artistic K crarige Beture EINC_INE =
nd - Effects - '@ Reset Picture

Adjust
| SR SR R
=)

[ AN I SO SR SO SN U 4

FE A, & 3 A0, : Far (NSQF @2 - 4) - 3= 1.6.32B

3 =T aEy W faes Fe fafse sae any &2 | (Fig 14)

Fig 14

4 Teeye #t 39 | (Fig 15)
5 f9aR 3D UTHAT T ITANT ek Thae AN F¥ g [0y —
Tt fieEe whae 9 (Fig 16)

6 AN # A™eye IF F2 | (Fig 17)
fafsrr whaes 1d arET Aot F: T FW

141



Fig 15

e

‘ 3-D Rotation »
—_—

Forward = |2 Align ~

CZ Picture Border ~ | j ) Bring Fe
<) Picture Effects ~ 3y send Backward - [g] Group

~itian_IAlran

‘ No Presets
»

Lk
y =
|

e

&, 3-D options...

FS

Fig 16

Fig 17
L3 Send Backwarc
Positi Wi
OSYIOI'I T,,’:E ?{}Se!edlon Pane
- In Line with Text -
=
With Text Wrapping
= = =
sl =] =
=] ] @l -
[ More Layout Options...
142

qifsrem g I & o e F1 === #9 (Positioning and
Wrapping of Image / Clipart)

1 o faweT gaaT siasae # 3 e W e |

2 o & &W iy faer § § g € I sfasiae & q8t I oA
| (Fig 18)

4] Bring Forward l;-“l
ENE . Send Backward - 1]

o Send Backward
Position | Wrap
v Text I‘E“ﬁ)SeI\‘zmon Pane  Sh

— - In Line with Text

Square

Fig 18

| Tight

Through

Top and Bottom
Behind Text

In Front of Text

More Layout Options...

Y AT | T =T T AT FSHA TWE TR
TEaT ¥ |

3 I IR FFT F ST FF AT AYS FT =T FY |
(Fig19)

Fig 19
& picture Border ~ | j & Bring Forward -~ |3 Align ~
< Picture Effects ~ & Send Backward ~ I8 Group

Position Wra,
Lﬂ Picture Layout = v Tex‘tE E{; Selection Pane S Rotate

| .- -A

JE. &, & wE A E.uw. : Far (NSQF @R - 4) - 31 1.6.32B



frme dstee @ w oA wW
Layout Smartart)

1 78 faFer g & o fieee = fFas &7 |

2 fOFER demse # gAHT dese & 999 #¢ | (Fig 20)

(Inserting Picture

Fig 20

References

Mailings Review View

-
.Il -
-

Layouts |

3 TS & WTEATE & A1 T S & o BTN HT FI7 FY
Td Sevd & feare & e i | (Fig 21)
Fig 21

Type your text here 2 f

e R
=l (o

sample

Hexagon Cluster

Use to show pictures with assodiated
descriptive text. Small hexagons indicate
the picture and text pair. Works best with
small amounts of text.

Learn more shout SmartArt graphics

4 TEI ATHR A IUAH & T ATAAH 2, o= H 05 w4

5 fafvwr sgedt & fod g =id faset &t swewE |
(Fig22)

Fig 22
[
Format
@O
< .0 .
Change ) C
Colors ~ 3

SmartArt Styles

I, TR F AREE AT F AT T\ 2, AH
T (A A FT W) TS, TAA WA HE SR
IAF ATHAT HAYAT AT T & U 2L, IR Y T TAA
T TR & I3 UF TR & A I K @ & |

fi=ew #1 dwus= ze™T (Remove background of a
Picture)

1 fIea g 39 8¢ F3AT (eg. tulips.jpg)

2 fUFEe #1799 FX -> B g g4 U JFATSE e AT
Fig 23 & gamr T |

Fig 23
a9 o= __"Egmm- Microsoft Word Pictie Took |
Home Intert Page Layout Referencet Maitings Review W Format
@ Corrections ~ 1 Compress Pictures | P —
- g Crange Picture ol il ol ol ] el
Remave == — J
Background | Artistic Effects - g Reset Prcture =
Adua 1 Prctiare Styles

3 SEIS< W) & 999 F2 | (Fig 24)

Fig 24

IFITIvE - Rt TR 9R @ TEar ¥ | awrEihe w
# o, o w7 aagw e | R w g
o e it SEE smETE & g (8) @ geEr o
FqFAT T |

4 AT F IFURE< 2¢H * o A7 I=~a 1 G w9 |
(Fig25)

Fig 25

r |
O CECIER e
Background Removal View Format

O @ & @ v

Mark Areas Mark Areas Delete Discard All  Keep
to Keep to Remove Mark Changes Changes

Refine Close

e Jwr Retere (afom) faeem | (Fig 26)
e AT At Sor T fw 2 el TR HE AT
A E |
TAVE T A 9 F (Insert Shapes on the images)
1 Staga< # g8 H ST |
2 Z\é Hig & Y 9" &1 74w F | (Fig 27)
3 AW W Aaa s | (Fig 28)

4 3ET F gH ud e ud STt WU & AN F¥ |
(Fig29)

FiE &, & s A .EuA. - Far (NSQF = - 4) - 31w 1.6.32B 143



Fig 26

e : weewteA w4 Fig 30 # @ & |

Fig 27

Insert Page Layout References Mailings Review Viey

jummﬁﬂ @:H g

Table @ Picture ClID

Tables Recenﬂy Used Shapes
%I\\l;:lC})DAl"L@GG
NN +
Lines
NNNLLLRAUNAG %
Rectangles
FEREGEREREE

Fig 30

5 St 99 w=TEd uens an] # | (Fig 31)

Fig 28

Fig 31

Fig 29
Documentl - Microsoft Word Brawing Tools
Page Layout References Mailings Review View Format .
] ] - S shape Fill - _
Abc ] ‘ - L shape Outline ~ | 1‘_‘.\\.
— i | ¥ ) Shape Effects ~ L

Shape Styles WordArt Styles

FIEA H 8T HH TS AT A |

TeEH i YT UF ST w1 (Grouping & ungrouping

of Objects)

1 F9 F & ford T A @i |

2 gad fFraaeTe #1 ST F e el orrd gad w4t o Fig 32
# femmr mr 2 |

3 fFATSTE T 99 X UF 79 afE At | F© ieiaed I
T & Star Fig 33 # gutfar o 2 |

4 FStFe YT FA & ford A T wi¥e aq IO ATOH
4T Fig 34 & aqmar & |

o fFATerTé gy 8 7% @ ud fafvw isimea A de g 2 |

FHT Y SATET T ITANT FLh ATATEH T (AT (b ATE T |

5 s & e e 08 |
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Fig 32

1 2 : AFATE T gAY Rt | w

1 AT BET | I e W wSY o q@ el A9 fEa
¢ FIAT 9= © |

2 < 3 7Y, e = fFw Y | (Fig 1)

Fig 1

()

=

Equatiory Symbeol

Symbols

3 WA A 3T T 1 29 S ATT SAE HIAT Wled @ UF IH
¥ o F¢ gae FY | TR ar wie Reaew W e w9
R gttt ate &t siaw #2 | (Fig 2)

4 St fEd T 8¢ FIAT ATed © SH oA & ford FAT A
TheT &Y |

fafir wie &t % R gg & Rl free (Free) ed € @

AferdY ITAT | arer Segoe Ul Symbol wiv &< & gid

g | g ®iT &t ST JTSST H¥AT @ I A & ot Rt foree

& FIT e Gorae? g1 |

5 frad g2 ud 38 T saa-faas & | e st e #
3 & AT | Afe o ST fvee d9¢ A8 FIAr Aed
AT Fw O fFE F aEd © |

Fig 34

20 2@l MAF AT RDOEIx
A L e = I IR e
~wolll V[ X X X | X |+ |4+ 4 1| 4] 1]

Latelonmt SEarHA B, | Bbartot b 7T, ARe R

fq - =¥ g s Rewar w921 A1 Bter FAT A=A
£ O SHH gART W ATEA AT A A |

afe oo 7€ et Y ST # aFaTe 8, ar
ATaTheae | AT T & a8 o= s F+T A | gqF a8
# STET ST & ford 981 1% - ATaisae &1 I
FXEH o ATH AT gAY e ST # A |

TF WA I A8 U AT q A (§) (A special

character like em dashes or section marks (§))
1 o Y TRl oT Wo FFEY ThE FLAT qed © |

FE A, & 3 A0, : Far (NSQF @2 - 4) - 3= 1.6.32B 145



2 fa@® #< - Insert>Symbol>More Symbols.
3 Rraw st afdm § Wuw w9 ¥ Fw w1 |
(Fig 3)

Fig 3
Symired - il
| [-Somboln | [z Crarssices
aharachr Sharoul key
- Em Dk Al Tl = boa -
[ Dby Chri=Hum
Honoieakng Hapsen Chrls Sarts_
Opt enal Hyphin Chri--
Em Space
EriSpacs
Capgrght “AR-THi-T
€ R sbered Alt=CTti-R
Fraderark EUE
Zectinn 5
Paragiaen
ERipen Wl 1
Sngle CpEning it Ciri+’,
wngle claving Gusie Cird+”
Dpudlke Jpening Quals Ciri+
Doubk Clzaing Quabe Clrl
| adboComad,. | Ehemon ke |

4 S FEFIT AT ZEE FHLAT FEd & I UL ST (oot He |

o : 3o wWww FFRH F AT AEHRe A 1 I T
2 1 af2 3y ou Wvrer FFEE w FERT AT K IIAT
# AT A € ar, Rk wdwe fiew awt T |

ALT+CTRL+C &fierge fraa (©) = 8¢ #a¢, s

5 5@ o @ (fafine) Faed 398 FT gH © at FTw
et Y |

s (1/3, 2/5) (Fractions (1/3, 2/5))

FB T (1/4, 1/2, and 3/4) @a: & wwe Hiae (Y, %,
%) W@ AT I TET FA & | dAfhd FP WE ARl B

4 - 3 : ¥TX UT FeX HT ITAWT

2T U Fe¥ BY STRgAT # FHUL A9 ud g Ao & &7
g € 1 (Fig1)

Fig 1

T ® T4 ¥TX U Fe¥ A 40 (Insert a predefined

header or footer)

1 8¢ 39 U, FX UH Fe¥ AYE H, T| AT F¥ W Fw
w2 | (Fig 2)

(1/3, 2/3, 1/5, etc.) gafer U& fraer &1 §0E Fed & ford g
forerer 99 &1 IUARC FHEAT BRI |

1 &t % §0E FeAT & et a¥ faes F¥ |
2 fa@® #¥ Insert>Symbol>More Symbols.
3 HEAe gIesd | g4 7Y ® | (Fig 4)

Fig 4
? x
w | Subset: Latin-1 Supplement b
) e i_Cur.renr.}' Symbols e
= a LI { Combimng Dracrtical Marks Tor symbols
| JLetterlike SEmbm
» . "
= C C | AT
[ |Mathematical Cperatars
= E e: higcellansous Techmicel - v
= T —
30 O O 0 OO o MY

i lelvlelmlolml il ] ]

T : AW FIEH F TG T qa9e T8 2 | afy sk
I & WY W AaET ITAT AR & af SOt [
T T ST FEAT T | S & & ("R R
W F= & o) |

4 59 %W F T8E FAT Aed @ 39 T Sao-{FeA® wY |
5 g Y T #9 |

Fig 2

=k [ [
Header Faooter Fage
- o= NMumber =

Header & Footel

2 ST ¥ AT FeX AT AR & 39 W FAEw F |

FEH TS AT FeX 3¢ F0 (Insert a custom header or
footer)

1 W€ 3T WY, T & Fe¥ AE H, fFww F¥ FW AT §ex |
(Fig 3)

2 faors X ke g a1 ulew gev |
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Fig3

= 5 (7

Header Footear Page
v MNumber ~

Header & Foole:

3 T TR TH AT F oY, Romga A e qu & s &
fasheqml T ITANT FXFH RS AT AT(hRT A FY |

A - F2T A1 Fex Fawer FAEY A T ATOR qWTw ¥
IV A7 FA & o, e A0 Few A T AU univeE

TN FE AT AARH USTY 3T AT { G OH G
Fev I fRw Fv 3® 'a w |

TER O & FTT AT Fe H T AT & L AT T & frer wn

1 STgdw & Tee 99 9Y, 8¢ AT Fex URAT # oo fFs
eyl

2 T & T T F A=Y, ewgw 9 #, e qO &
F¥, REdI= &€ 9= 9% a9 1 Fas w1 |

dte : R AT TR | Office Word 2007 #
FAY TBI H1 TR A AE0 O i 2, Different
FirstPage fFr mead A i ez oA € | T 99 A
TF 2T AT FeX F IWE AT AAMRA FI4 A TTHRIAC H
ISt H THTTI T FAT |

3 w9 €S AT FE O $e¥ URAT § 2T AT Fed & Fec
Ft e § |

e ug gaq (FW ua fomw) oo & fom ster-ste gew ud
%Y a1 (Use no header or footer on the first page)
1 e @@ aTet 9 O) fFdd Y o9 SEgHT # B O |

2 TH AT G A A §, RS A d9d (e 9H) 9%
s &3, A s (Afe Iom/faw 7)) |

qte - AT ATIHT ¥ TF Fe¥ F REEA A9 T8
e 2, ot saa Feeer & Rl =it e A 39
e E |

3 2°H UF Fo¥ g & A=Y, [IATEA a7 u¥, sAfwrw awgE @,
oo aife $av oorad 3% are #1 T99 W |

AT ud daw (W9 v faww) oo & ford stemt-srent 3w ue

%Y sAn (Make the header or footer different for

odd and even pages)

IETE & ford, ST STRIAE &7 90 offe T aTet O a% fored
TF 73 T 9fide a9 FHE AT 9t ¢ | AT, gFae & ford,
ATE-U T O & AFa¢ I Y ford ud §a9 & are 9t &
O FHIE O % AT AR ford | 37 A8 &, O T3 W 9

Fig 4
r d «} L L Hender & Fgater Toak
Home Enyert Fape Lepoul Dursign
B
] Hender = [ 1 3] Quuiric Party =
o Footer - & J i Prtare Fages  |h 08
] Fage Number = g & Clige As o]
fender & Foober I ert J

& f<l & e 8 99 99 Mt o # e R S |
Stae # oite Ud $a 336 A1 Fed A (S ot a dsT A
T HT SuAT wE B E)

1 e H@ atet 99 X fFd #Y S STaHgHT H HE 99 |

2 ¥|E AT UY, ¥SW & E¥ YT H, X AT Fe¥ W faAw F: |
(Fig 1)

Fig 1

Header Footer Page
ot i Mumber ~

Header & Footer

3 2=H A1 FeH MW A H, AR a1 daet (AT w9W) W
s L, o9 ey (A aow/few gw) |
AT - AT ATTHRT 2T TF Fe¥ F REAEA # A T8
frad &, @t o weEe & e < e |9
FT TR E

4 FH Ud g T & A, RewmA 3w v, st e
Rt ife dav Iorae 3 are &7 999 F |

5 %X Fe¥ T & A=Y, Rwmgw 3@ w¥, Afvdww g A,
ﬁwﬁm@w%aﬂ%waﬁwm%%ﬁ
Td Fe¥ I W A A |

6 2SH FeH o8 & A=Y fIAZA 89 § ST FexX Y0 H, X
Fex T fFaw F |

7 2T Fed #f Aol |, g6 95 % WA aret e ¥ s
F O e (339 9) |

e (NOTES)
afd ST BT Y, AT BT AT Fe¥ F RS F FIH H Tl
g (39% fort 3oe &1 =9 Fa, AT Fgue (AT goar
& wAT fawert # 5 ) |
faferr oot & a7 g9 3¢ A1 $e¥ R e A % o, 7w
=@l Ft qevd ud Aot & faferr 8% a1 v &t o §
9|

FE A, & 3 A0, : Far (NSQF @2 - 4) - 3= 1.6.32B 147



R siaghte § T2 @ 32X/geY & SH AT U9 dav e A
% T4 (Create odd and even headers or footers
in a document that already has headers or footers)

1 TS AT Fex URAT # ad-[3as & |
2 2T FEX TH F 9N, oA @ wy, oAt yu A,
e ot a9 o =% ST FT 997 F |
N WISET 8¢ AT Fe¥, famw 7w & 9=t & ford #iffmre &t
A -
3 W & T T F aay, Rowgw 2 v, Afeew g A,
e e |5, | T e A arf s dew F g
AT Fe¥ 9T FSX A UF Fa9-T51E 9o I¥ 88 AT FeX
T T |
X AW a1 a1s | fafvw 2w @ gew samn
7f3 ST STRJAT AT (Faer) | fawfom &, at o s
T U FeT F {97 FT At € ATl a8 BT ATH & ford Forarande
(ATwT) wefitd ¥ | IRTE & ford, A9 a9 1T AfS AT
etagawe arat § fawfora e gom €, at ars & s 8Y aTs
& ¥ ¥ yefia g |
fa - ot s ffem =& € & s iR |
s # & 8, snw 7w | w @ # | (Fig 2)
1 Wa¥ X ¥ 3w I Fas w7 |
2 & a9 T, wEw g9 # Mg aT s w |
3 @@ 9T fFew w1 |

Fig 2

I *
& TR i

Lk
ih e

4 ST H G oF god & ford e 9¥ fFew #Y |

5 e o & FIT SAIHE § R o9& @7 & fod e o
X fFeE w1 |

FrgA= # &FW 3% A (Add section breaks to a docu-

ment)

o B e S | b

A AT SAgHe agEnT & ATt 7€ & @ o O &

JEATT | FAY IGH Tl AT AT-HAT 28 AT Fed q1ed ¢ |

1 Afe TRt STagAe agEnn § fawTfor 72T @ at e 9w
F EATT § FAY T TET AT AAT-TAT 88T AT X
AT © |

2 O AATIC 3 I, I AT YT & F_Y, 77 I fFs Y,
o A dae & =Y Aae O 9 faed w7 |

3 T O AT YEATT H FEY T AT AT AAT-AT T
AT FeX AR €, SF T 918 H Tl I |

4 O FAATIC ¢F UX, U e JU |, Foq W faes w¢,
T S % =¥, Ae U I¥ et Y |

5 IrRAT W AT FX G900 3% oA & ford 3 ud 4 =720
FreT |

T2 AT T A B I F o stEgew ¥ AW aw

Igai #A1 (Use a document’s section breaks to vary
the header or footer)

73 ST STAgA TEer § & fF (srgwm) # fawlee €,

T ATT STH TS TH AL HIA o (o7 ST T HT ST

T AFA B |

1 STHgA< & IO/, T9W AFATT X s w2 foas o
AT BT AT e 7 FA7 =18 € |

2 Z9¢ 3 U, BSY B YU W, 2T AT e W faww Y |
(Fig 3)

3 fFo® # ufee &= a1 ufee Fex |

4 A wed 39 ux, At gu A, fFow w1 e g e
] fort o g % e fe Sgen ¥ g o R
& 0 AT FARA TE AR |

T iEEE

Header Footer Page
- - MNumber ~
Header 2: Faoter

5 WIS[ET 88T AT Fe¥ H a8 AT 30 AIHNT F ford 7T T2
a7 Fel T |

6 fouirzw a5 & Afawvm o # (I FeX FieagHAA <),
W@W@W%ﬁ,sﬂﬁmaﬂw%%@?m
Fe¥ U FEHE TAT FAET |

7 =€ Fed o9 WY, Afawee Iu #, fFaw X fow g fifew
s g8 g AR fser e % fie § 89T AT gex
FT FAFIA g€ TR |

8 WINET 8T AT Fe¥ aaat AT 36 AW & ford am dew ar
FeX aqd |
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9 IfEgAT F BT AW & ford a8 =2 FEe |

YW i ASST A A BT AT Fe¥ & STANT w1 (Use
the same header or footer across section boundaries)
STHgHE | Rl el 28% AT Fex¥ #a9 gir fre gtar &, o
T A HATAT T FST AT FeX F FA a7 FFA © |

1 39 TS AT Fed X a9 faad &< oF AT AT A
et & a7 o @eer Jed € |

2 e ged & R, AT g, Fae dw |5, )
I

4 tfee a< 2007 g#& BT & 7 o9 I8 2S¢ ud Few
geT &Y, fIoe A9 % 88 Ud FeT & A1 91ed & |
T8 ¥ fads w |

FTT AT Fe¥ F AREA AT FRww F g (Change the

contents of a header or footer)

1 gud 39 X, BN Fe¥ 9§, fFw X TS AT FeX W
(Fig4)

Fig 4

- =l 5]

Header Footer Page
v Number -

Header & Footer

2 fFas # ufee g a1 ufee gex |

3 U BT AT Fe¥ H T8ATd T & ford TS F FIT FLH
IR qeAE FY | A7 e el goa 7 i g7 fawet &1
ST ¥ TR &t AT FL | IITEXT & ford, T wie
A AFA 8, AIE HHE AT FT TFA & AT AT FIT FAT

AN FT qFA & |

TIP fre dese =1 &, (= dstee o - 98 sagae
&1 gar o famar & R 9t B 2w % arg ) sa.
e W % 22, TeAew, Fiew Ud dae S
Foet swen witew (Rafe) & s smamm) | s
T & AT, Fe¥ U TEGAR & ¢ & O A R
F HFA & | Toh g T AT ¥ U T R w AT
T gU TgHT-eEE Y |

9w R A< FIAT (Insert a page number)

TS AT ST | Teol & &7 TS AT Fe< AiSg & ar 1T 9
T (TS FHF) A TFd & |

afg o Tewt & & wide 5 g O T F RAEA #1 swE
FIAT AR &, AT STT ST AT eI § 4 AT & SATET AR
e & At ATHE a4 78 © [ T8 o7 O Ja Je
FAY T AT IR AL |

-y T T e T T fee A e A A
ot T T g A E

O 7Y S0 A % 9T | FTET AR & ford | §09d o T=d
Eic)

e & Wivg W AT X W 99 A= e (Add a page
number to an existing header or footer)

1 BT AT Fex URAT | T - faots &7 |
2 &l T OST T T ATed & del (s #Y |
atea (NOTES)

ATTH 8T AT Fe< & o F6e a1 f&rfq e w1 & o,
T UG FY, UCATE AATGIAT FY, AT Hig A I8
FEAT 9Ted & 98 F2 |

FEA AT 8T T Fed F AT 39l & &9 | &id & U4
T A AT FIA UL FAC AUA AT & AW q@dT JAr & |
9 A |/, 3T TIT I & o) Fegier 39 99 W | TE
AR F A st TR A s F E T
TE 3qd & ©T | © A7 76, RaT & I, 97 Tew @ H
S, S FHT BST AT eI | & |

T A BSY U FeX R Fow Fgled @ & A
T(FIAT (LA TF 3T AF Foc Hf @I Fd & | T 3T
BT AT FeX A UfSe #37 & ford e &Y o F6e w@a: &
FeE Hrgiel H I AT | Hee Fegiel & HEL H 5 % ford
(AT T Fee FglA % Frec & B AT 95 T/ A
%), o U AT WEE U &1 T ITANT H |

3 W¢ ¥ WY, ¥ Fe¥ YT H, O WY W fFes #W |
(Fig 5)

Fig5

=) (S (5]

Headear Footer Page
. NMumber~

Header & Footer

4 FXT qiforee ) FEE # |
5 feomgm &t ot # SRy O A & e 94 |
TER | FiHe R g O TR & o A deX U gew wwe

®1 s1ig«r (Add header or footer content to a

preformatted page number design)

1 8¢ ¢ 9, ¥ Fe¥ IO H, 99 T ¥ faaws #+W |
(Fig 6)
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Fig 6
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v v MNumber~

2 SrHgA= ® et WY o7 9% qWY S[AEr Aed § Ik
AT ST ATE 9T, dfedT (% 95 a7 o AT 9%
fFa® #¢ |

3 oo fAS ¥ AT O AW} IS & wae Y |

4 = & a8 F:

« 99 q@Y & T8 BSY AT FeX STAA & ford, 8 Foil 97
T, Frec STA U He &l T de 2 & ford & gt
T T |

« O T F A8 28T AT FeT & Fred S & ford TS Foir
T, 3T Folt IaTE UF Fee A |

o Ffe oy O Wil festea § / feomeA #1997 #a & ar
2T AT Fe< # Fa® F3F A0 Fee =14 |

Fzw (NOTES)

+ BT AT Fe¥ § WROUTE JeASHe F4 & ol a1 Fig o=
FIATT FA & ford ored et FA3 &t B qe & 9
ST e Foit qamr st |

+  Jgd AN 88Y U4 Fe¥ & [T daq F FI H Bd § U o
#T FIW IT FET I AT &N AT qgaT AT § | a9 &
T § 3T BT ST & ford Frgiel a9 a2 | T a1 4
EACEEEAEC G R Tad I S L A R G i
T H & a1 78, Ra F FUY, 9 77 I/ A, T FEL
2T AT Fex | & |

. dg AR 3 UF pex R wew wwiew wad § ot
ST T UE ¥ OF T A wie % § | o o
ST 1 X A ufew T F fordk P A & A AR
& Fe T A I N | T A T A A | e

3 i W foe () #, wEag W fFes ¢ | afy s
FTEA & ATH & AT I WY ATASA FEAT A8 @ Al USUTT ¢
FIEAAH 9% A9 F 9T HY |

T - AV Y AT STRA 9T T & Wieg HE IHFT
e & ot 7z giefvae = & fie Fie & a8
FAFR T AT T T TS T@AT AR |

TRMAT & NTF, SAE@F HT A AT AN THRIAC NS ST

# fo@ (Insert the document title, author’s name, or
other document property)

1 2T AT FeX § FAL T8 o AP STaf AT Sragave et
Ed AT ATed € |

2 2T Fex TH #, fewizw ¢7 uv, g\ Y0 A, faaw ured ™
et Y |

3 TEgAT ME H ST A WUEl AT 9red § 39 9
et Y |

gaam fafy s (Insert the current date)

1 2T AT FeX § FEL T80 o A et g I (fafy) s
Tmed € |

2 BRFR THA A, T A W, W O A, ST TmA W
s &% |

3 ST ®HeH AT § a@ ®AC gq foraw ema fafyr &
feamr =Ted € (@ AW Afe oy =Ted € at) |

2T a1 Te¥ zeT (Remove the header or footer)

1 Sfaga= § FEl 9T A1 fFds F:2 |

2 Z9¢ 3¢9 WY, 8T, Fel YU H, BT AT X W s w7 |
(Fig7)

Fig 7
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Header Footer
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MNMumber ~

Header &L Footer

FEiel § FAL F e & fordt (ATl AT Fie Fegol & Froe
F g foAT 9% AT ST A%) A% (ArAr) UL AT O3
(3Taf) O FT ITANT F |

TRMAT FEA H AW oA & fod (Insert the file name

of the document)

1 2T UEA[AT FeX § BN ATT FIEA FT ATH STAAT ATSA &
Fet T faas w1 |

2 2T FX T & 9 RARA a9 W, W€ 9 H, FAF
ared ¥ fad w0 diee W fFw w |

3 fFaw w¢ R s ar Rya gex |

X STagA< § 2TH AT Fed 8¢ Jad |

AEWTF - Afg s i veet - o & T A e O
g9 ¥ a1 Fed g € ar fRw OR v an s
& S S| ® 92 W € At @ e o an s |
X AT FeX g gAtwa W
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FE 4 : FEATE At (VTEA) T AT THE FIAT
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References Mailings Review View | ‘
WordArt
Abc Abc Abc | - [ Shape Outline ~ ! )
[ ] [ J ¥ ! Shape Effects ~ A d
Shape Styles
O > )
5 9 fie faseT &1 ITART F¢a Fae (Tr1) WX | (Fig .4)

6 9T SATITATIA (AT HT ITANT FHT ATIearsd a3 | (Fig 5)
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Fig 7
[Drating Toots!|
Review View Format | |
& shape Fill - o A TextFill -
7 Shape Outline - A A A . & Text Outlir
[ Shape Effects '_' 2 [2) Text Effect;

() e | ot .
L ﬂ

4 |:J Shadow » |_|
] Presets
() Refection »

f (Joew .J = LV | |
- j 3-D Rotation » i 3'09”"“@|

FT 5 : grT 3¢ FAT UF R (gem) A
1 IR & TEd AR & g |

2 WET ¥ W, IRE YT &F AL, T FT A T4 AL |
(Fig 1)
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Text Quick WardArt] Drop
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et
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o Date & Time

3 S I F fawer o ATed § a8 I |

o T WETE # e g At give &9 & o, gte g7 |
(Fig2)

Fig 2

PAGELAYOUT ~ REFERENCES ~ MALINGS  REVEW  VIEW
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1l Chart W o I‘ » Bookmak = Dtooter A Worddt> 55 Date & Time
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Expanded or Condensed
electing Expanded of Condensed alters the spacing between &l selected letters by the same
amount. Kerning atters the spacing batween particular palrs o leters - n some cases reducing and

in other cases expanding the space depending upon the letters.
Select the text to change,

o U WETE & qTEY, Al & @ g2 9 &9 & ford, 37
w1 99 | (Fig 3)

8. wfaw & #@av & forr 97 # a7 FF @ |

Fig 8

Fig 3
PAGELAYOUT  REFERENCES  MALINGS  REVIEW  VIEW

AR A an — Pl =B ¥ d
| SmartAn P W [a 1 Header Ik ‘\ Qi Parts :Slgna'lulehnt
Y1 Chat e O\ ¥ Boolmark ; 2 footer+ A Wordit 5 Date & Time
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rations Add-nt Media Links Comments  Header & Footer
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A In margin

& Drop CapQptons.,

Task 2: Change the spacing between characters

Expanded or Condensed
electing Expanded or Condensed alters the spacing between all selected letters by the same
amount, Kerning ahers the spacing hetwveen partcular pairs ofltters - some cases reducing and

in other cases expanding the space depending upon the fetters,
Select the text to change.

VT - AT FTY FT FT ATHY, i TF TRT & ITH T
ot I T & | T2 T F o g 9 - 3o F Frwe
T R FY TE AT F A=Y AT 99 &+ |

g7 %7 geT=1 (Remove a drop cap)
1 a2 g 9 deX F 999 HY |

2 IWE AT H, IR YT F AT FIT FT § SATHE A7 I¥ Forh
|
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: Droj s
Cap‘: [ Object ~
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A & s Az, (IT & ITES)
w1 (COPA) - ¢ safi stweae

v 1.6.33

tw dAee #t ARdw ud srRmw w1 B wwr (Page layout setting and printing the

document)

IR T AWM & o § AT FIA H q6H 81 G
* STHYAR | 9 HT AR FAT
o TFIAR A B w2

sawward (Requirements)

AT [SUHLOT[ATEA
e U% Iferd PC faveta OS wa MS e 2007 & am

-1 No.

wiwat (PROCEDURE)
FE - 1 : SHGAT | 9 FHT AT FEAT

1 O AMEE T UX, A FeAq T & A - qfr FE W
AT & foets w2 S o fesra favet gom | (Fig 1)

Fig 1
h HOME  INSERT  DESIGN = PAGELAYOUT

Py :_L‘@ .-—.?—‘ ILI ’;:‘: .
[B} —‘_ “ | [==| ‘'—Breaks Indent

: = : i) Line Numbers~ | 3= L
Margins Orientation Size Columns

- - -

be Hyphenation= | ZERj

Page Setup

2 W 39X, 999 & A=Y, Afewdqd 99 d At & § qF
ieg . ART=IT FATH ATT A=y & SR | (Fig 2)

Fig 2
Margins | Paper I Layout |
Margins
Top: 2,54 cm — Bottom: 2,54 cm
Inside: 2,54 cm QOutside: 2,54 cm
Gutten 1cm Gutter position Inside
Orientation
=~
Portrait Landscape
Pages
Multiple pages:  [EGERTGIaN—| - |
Sheets per booklet: Al B
Preview
Apply to: |Whole document
Set As Default oK | Cancel

e - ATY T SRR Tga AT & AT T IH ATeF THhAe
# s wean =mes €, B oo are @ o g% (Feama)
H giq 7w € | Mew W FFAE F 79, A W THFAC
e A g

3 aEfEw % o ww @ % o, wew & fagy (et T

3|

4 99T 3F U, 99T & AESA (J@ER) g7 | A W@ F gEac

T A ATHRR I AES & 1T @ | g fAfvad w1
e & #E ST * 19T Ted & & |

Fig 3

[ Margins | Paper | Layout |
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Al
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Legal

Executive

AS

P.
FEirst page:

Other pages:

3
2
n
-

ABph [ Print Options...
] (o)

T : AT FAIA JHAT F TTEA (HETAE ) H FF AGHLT
ST Td € | SITETr &7 9 9¥ 91EY i @A & ford,
AATIT 3T I 9 A9 faugl § Tisd av s &9 |
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5 % 9 fae® F¥ | Al AUH STHgAT | U8 & & §°
AT €, TS AU AT FiHE B THT &, ATHA ST H
AT TS AT A FHS UF qA APAAT USHE HIA
F e TSt |

e - 7z Ffeaa w2 1 sam after & & daw wiim

| 9EY 9 AW (3% R e F I - a9 e w

Tze fFaw FW) UF Aleithe JaF, ATEihe T Frewd

¥ fRTw wW |

9w M¥Ueww #t ey A1 qige | 9« (Change page

orientation to landscape or portrait)

1 I STHgAT & AU J@aq & fod demse # Ja
ARu=eT 97 |

2 g AT deed & 99 | (Fig 4)

Fig 4
=
[ ]
Orientation

- : -
‘ I ‘ Portrait

D Landscape

efHgdwe & Fo fow & dewhy # agar | (Fig 5)

1 39 Fc F TIT FL 000 ATT Arewhd 97 ¢ IGET AT
gl

2 WIS IX T, USTHEAT AT a1 i Giet |

3 AS@T & FIAT F¥a, UATS ¢ a9 | § Holaes e g |
(Fig6)

4 ok ¥ e @Y |

9w AW 1 Ae FIAT 9 S (Change or set page

margins)

o= 7St faser (Page margin options)

« g EtEn & @ wiw Seer (Add margins for bind-
ing) S STRgA= AT dE< FA @ A9 W & IaW
TEHT & A@1ES | ud g wifow # AfaR<h e aF &
ford e WS\ &1 Swmr #R | wex Wi aw v
T & foF arefE & #rewr & de g T @wdr | (Fig 7)

1 aEeT & fod wex arv=
2 fET 9o & o i arfore

Fig 5

Fig 6
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Apply to: | Whole document

Whole document
Selected text

OK Cancel

Page Setup 7 >

Fig 7

=
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« %RET 99w % fo@ \ifw #e ®Ar (Set margins for
facing pages) Sae ATESS STAGATH & HRAT G99
o Wi Ae-s1T & & ford 9 g wnfia & 37
F H, A% (IF) I A A, I O & AT @
FEATT (7T =T Y AT AT AISTE aa¥ gnfy ud
qTeT 1 ATfo o aEw #t 9reTg #t &nh) |

e - afy Tl & o il @w () & awa
? Ud Tigaw § e i & @t e wifiw &
FLA H ATAIFAT 2 |

+ g% Wiee SAieAT (Add a book fold) O &Tq SFAAT
JEE W g WS [AFHeT F ITIART F¥ah, ATT FHae aar
A € | T g fawer 1 ST #¥F Wi, At
(STH=OT), e THH AT FZ W AXE FT STRIET AT T
A=Y Hieg FY &7 & o471 g% & | (Fig 8)

Fig 8
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|
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1 Word inserts a single, center book fold

99 AIA @2 FIAT U g9aq1 (Change or set page
margins)

1 99 AATIE 3 I, U HeAq I |, Aforew O faa®w FL |
(Fig 9)
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A &1 =39 #3 & o wew 7w | o9 few
AT g |, Reree a7 a¥ fFas ¥ e | ) fFow
FX | Tt Rwfee afdw dwce & 49 & I & few
TlRgHe AT & | 8¢ 747 Stagaw S | 39 el W
ATYTRA WM 9= 3T 95 AT &fET 61 IT=T F+310 |

o Tt Stagaw & Gt Rww & AT agem & ford e &1
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T 7 3 fIw & o STaeT # o € | uw a9 o
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afdw & Tedt UF A8 & e & ag | AT ATTHT STAgHT
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Feror I¥ faer® AT aee @ € |

9w AW @1 (View page margins)

1 wrEwEe Aitew geq (B4 o fRer 59 & e, 7@
A 9T T w7 |

2 usarEE T e #Y, 3% 919 W ST FRe & a7
M IR LA o a1 I% s w |

I AT 39 ST § Siee ag™ & &7 # ffwrg v |

AT - AW O AR W At R AmEe g AR A aw |/

TS of H 39 qFd & Ud I H TS AT e oW
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HRAT G (U ) 9¥ Wikt @ & #An (Set margins

for facing pages)

S AT faeE Ao & gAd € e 99 @ w1 Ee (3)
O F AT H1 (HeT FAS BMT | ST A=< ATl ATroAl B
TF qTEY qTelr AT A AISTE avrEay A |

1 O AATIE 3T I, U AW YT F Fa¢ ATorw ¢ faerah
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3 wivt & fagy (Fie) agem & fordr Ao o2 s & |
fre wew Ao IX foFers &9, d9 ITET AN ATSeHTES
arraE §, o7 A (J=E) o7 wed € 98 3 Y |

TST SAGATH T TEX AT &t 64 X1 & forg (Set

gutter margins for bound documents)

e AT ST ST 3T A3 FHIA HT G @ & T8 158

arfee ug 2w wifo & sifafs sre strear & |

1 O AATST 3 IY, U HEAq JT % =¥ Aoy I faeras
#% | (Fig 11)
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ATT ZE AT Ehel & ATTH! HEg el (el & F 37T A e qIE
TS & Wee of @ & | @i awr % ford | Teelt 1Y ST 7
T g 15 fiee it gerar & a9 € |

AT F AeAl & Hiew aATT (Create newsletter-style
columns)

1 @AM e IX, Heww ) s w2 | (Fig 12)
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< ATTH o7 & (2ATd & Hieq Hf AISTE &f < H T | gfe 98
T HTH Tel HT T@ & T ATTH! alT & SATST i =1ed av
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FAAATEE 39 T (Create columnized text)
T STHe H R T 1 Wt afET & R ved dewE B ¥ | F Fig 13 F
fRar e |
Fig 13

INDIA PHYSICAL FEATURES

time is 6 hours ahead of GMT.

Geographical Setup : India takes its standard time from the meridian of 82 30E, which is us 5 1/2 hours
ahead of Greenwich Mean time ( 0 longitude ). Pakistan time is 5 hours ahead of GMT and Bangladesh

Cimnifirancra ~f | acatian - Rarrina tha nlatasn ~F Qalochictan hadhich farmm nark AF Dalbictan) tha fun arast
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2 =9 U AATIE F ¢ (TTUTH F HIAW | qgeld & ford)
ST Fig 14 & aortar o & |

Fig 14
Page Layout References Mailings Revie
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EE More Columns...
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3 AR e faFed g W Faw fawent & fAvet ga
SRR, HT T | STeT-3TelT A9 ST #¥ 3@ otar Fig 16 ®
FoTtaT =T |

Fig 16
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rPresets
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Fig 15
INDIA PHYSICAL FEATURES

Geographical Setup : India takes its standard
time from the meridian of 82 30E, which is us 5
1/2 hours ahead of Greenwich Mean time ( 0

Significance of Location : Barring the plateau of Baluchistan (which form part of Pakistan), the two great
ranges of Sulaiman and Kirthar cut it off from the west. Along the north, the great mountain wall

longitude ). Pakistan time is 5 hours ahead of
GMT and Bangladesh time is 6 hours ahead of
GMT.

99 st @< FT (Insert a page break)
AW 9 3% ¢ w0 (Insert a manual page break)
1 STet T 747 957 9% AT q1ed § qef (da® wY |

2 W T U, U9 YT F q<Y, U9 A% W fFoOw # |
(Fig 17)

Fig 17
=) Cover Page

_) Blank Page
%= Page Break

Pages

ITITE F S | O 9% 4%AT (Prevent page breaks in

the middle of a paragraph)

1 39 IRTUTE &1 999 F¥ 58 T I 9 &= T2 aF 9t o
frarfore 2 & a=T =Ted €

2 99 WHTSE 3, GLUTH SEANT S dAlea¥ 9 fFeasd F%
Td ATEA U 9 da9 ¢F 9 fFE W |

3 & AT GG AT AT H AT FL |

YIRTHT & = % 9 A9 &t AT (Prevent page breaks

between paragraphs)

1 I URTHRTHN FT T99 FY o AT Th & O q¥ T@Ar
med € |

2 O QATSC I UX, YIBME STHATT 1T ATeaX &l fFersh
F UF ATEH UT U 99 3d W faed W |

3 v fay A 3% are & 94 |

WOME F T2« 99 F%Y @A (Specify a page break

before a paragraph)

1 I ULUTE &7 999 HY ST 9 5 & a6 & AHarer € |

2 O QAT 3T I¥, WUTE SEAANT q(a AT=< 9 {Frsh
F UF ATEA UT U 99 3F W faed W |
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3 o9 9% R 3% ate &1 997 w1 |
UTEME F FH & FH 3 ATIA A9 F I TF A @

(Place at least two lines of a paragraph at the top or
bottom of a page)

1 IH ITH &7 997 e orad AT fAeisr ga Aihed ehnr
I 8 |

2 O QST 29 % ISY YTUTEH SNl (e AT I¢
T F UF 1A UT O S99 399X s w1 |

3 fa=i/atha Fiw =% ate & 94 |

A - a1 Rwiw a2 faweat | T|ar 2 |

IqA & | 99 a% | A+ (Prevent page breaks in a
table row)

1 9 F T O I fFaF T AT AT 9% AL &1 a7 AT |
I ¢TA g S ATT <A HT dF ARl HAT AR |

AE - TF ¢q AT G & TIT 2 IA AF FIA Al AwA 2 |

FF 2 : TTEgHE e AT - TTRpHe w7 fieg dwe
Tt STRgAE ey #T (Preview your document)
1 wEa # 9 U 9w fFas w1

2 B U & g #A & o, 99 & A= avw e g% W
T geae U IX fFesw w2 | (Fig 1)

Fig 1

111 [of1 »

7f3 T Ted % fRaTe & Sier & a7 39 ag™ & ford 9 & A"
TYH A FA1ESY 1 394 w2 | (Fig 2)

Fig 2

1L}
.

by

-i-

64% - |

3 W ATH HIGNT AT HE AT fahed ST 39 =red & ST
T4 F¥ 0 O Feq ox fFas #X | (Fig 3)

fafire as= = #X (Print specific pages)
1 foes #X ®1Ed & a8 fie 9 |

2 T T <F X fFdw F dsrse W fFas w1 | (Fig 18)

Fig 18
Table Tools

Design Layout

3 g« IT H W X fadsw w1 (Fig 19)

Fig 19
s B2z
Select Wiew Froperties
v Gridlines
Table

4 ¥ R fFaE L, IaF a8 JAIE A T AF THE TN
I T T s w9 |

Fig 3

Print

i

— Copies: |1
=8

Print

Printer

< D35-1525-a on prn-vcorpdtkS.redmon...
=, -
. Ready

Printer Properties

Settings
|| Print All Pages

I—] The whole thing

Print on Both Sides
Flip pages on long edge
=, Collated

1,23 1,23 123

e No Staples -

[ ] Portrait Orientation -

’T Letter

E 85" x11"

[ﬁg MNormal Margins
]

Left: 1" Right 1"

-

|f| 1 Page Per Sheet -

Page Setup
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2 ok $o ool #, AT SAAT TS WIS T AT gae Awotel AT
Fhed & e w1 & ford afewm & aew o o s &2
T B Afte 99| & a7 aTe O OY fFaw w9 o
faweT 39 |

Fig 4

Settings

Flrr] Print All Pages =

The whole thing

Document a

T-—_‘_1 Print All Pages
| || The whole thing

[=y  Print Current Page
‘ Just this page
AL!J Custom Print

] c
- Type specific pages, sections or ranges

Document Info
Document Info
List of properties, such as file name, author and title
List of Markup
Your tracked changes
Styles
List of styles used in your document
AutoText Entries
List of items in your AutoText gallery
Kev Assinnments

v  Print Markup
Only Print Odd Pages

Only Print Even Pages 3 |of6 P

3 FB & 9l H fie F & o A 7 | 7' w1

o Ty & gortar mor O fifT A F o, g e e 9w |

o UFH F d1F A O A e 7 F o 99 1 -3, 'R
e g7 ud o atem § gee oY ATy 9w #T AW ST |

o FT U IS AT O & a9 () O w & o (S
O 3, I 4-6) UF A H, I FEH B 0F 91 F T4\
ford e 31 for@ o1t & () ST Ste 6 gF &t (SeTeew
# forar 3, 4-6)

Fig 5

Settings

.‘“-'._‘1 Print All Pages
'J The whole thing

Pages:

E Print One Sided

Only print on ane side of ..

= Print One Sided

| ‘ Only print on one side of the page
Account

["—_J Print on Both Sides
Flip pages on long edge

E Print on Both Sides
-~ Flip pages on short edge

(41 Manually Print on Both Sides
Reload paper when prompted to print the second side

Options

I

gaete ¥ ford P afeww #2=1 (Print settings for booklets)

S AT et fiwe F2a &, at fr= afdwm &1 9% w3 7 glafeaa

F % AT F 99 F I argel e FAT € ud ot #oawr

3T | qeerd arfs i S & 8t 9 |

1 wEa T faas v G g7 |

2 Ffe e fimew Aicmfes fif (It aor ar afdw &
F¥ P aw wge # geawy B st Sty e 9o |
freT aote st wiE 39 faweT #t gAET s O W AT |/
FOY AN ATE i AT OF |

Tfe s e g1 Arge ffRr #t adte 72 #ar e | a« et
Fgerer e itw Sty JEgw T fFed FeAr e e e &t
U IS FLAT ST | 91T it 7= U e 7 g™ & ford ) smas
T & =R & FYA 3fe H IeeT T & 9 |

AT - MEAAA e 37 & ford, T A1 FeI & GA FAH
E | e & o, s sr A R Aw TR =
I3 & He Sey a¥’ A, 6 Ue faee ged % fordt s
I =Y WA A |
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A, & sEaie. (IT & ITES)
w1 (COPA) - ¢ safi stweae

e 1.6.34

F¥en & Iwa w31 (Use templates)

IR FH TVE & STl # AT FIA A HH & 0
o TEE GreET

o FEATER, A AT Tw F g st wRa fawer g
o HHH F TATA AT I FA

]

smawFare (Requirements)

AT [SUHLOT[ATEA
e TH wted PC -1 No.

afwam (PROCEDURE)

w1 - 1 : TR G

AT ITFRAT T T TEEET P& A1 (Open a nbew

document and start typing)

1 ATgRiETe A a€ 2010, 2013 a1 2016 fFa+ g
3% aq1E 7 T Fw | Tz Wi Te (07 o
fFe® #X ud g W fFow w7

2 =F TFIAE X - FY |

Foe | IFgHE % FY (Start a document from a

template)

A FT JEATAT faeg F & & ITT 74 F ford, fawaforfaa

FH F W

1 wEwETe AR 98, § wigd ¥ fFas & 0d g w
fFs #X | wEwEire AR a< |, AEHETE AhS
Feq W fFaw w7 |

2 TEATH F AR, T & TH A -

« afg o ATEEETRE @€ 2007 ITART FX W T ar I
FIYEY X ITAY TWCIEH &1 FI9 I & ok, FRree
AT T 999 FY | AR AT AZFEHE T8 IJTIN FT
7@ € at saaaw Fwew § a9 |

o ATEHETTE AR 7€ 2007 §, ATTHRIATER AR ATAATEA
& sra¥ forddt us foiw o= o &Y | ArewieTe o ad
2010 % 3t=¥ Office.com Templates o= f&® #X |
AT TR ATET g€ 2013 Td 2016 & frasr o Iuerer
A & g3 TWee o gH WEd T faas w4r, R =
faes #at at femE & | ud afaRes weled @9 wR
AAATE FAE] @9 At 9 fFeE 4 at e S |

2 S e AT ATRd & I X A fadw Y |

160

R F AT FIAT TH IR IHAWT F A0 (Save and

reuse templates)

7f¢ ATT TFTATS il g% SFIAIE | TS ISATT F¥h IG G HEAT

FTEd & aF AT 89 FiTh I/ AT IJTANT F Gt & | 0%

FTT HFEATTS HF G5 SFIole Hif 7 STRJA STIART aiad & HIS

TWeed T AT w F g Awa & | faft dvwiew #t Wi

TIACH BT § 89 FIA & fod, T8 W

1 ®Ew 39 T¥ s w2 |

2 @ g W fFoaw w2 |

3 W UH TEQAM alaN §, TaeH W FaE w7 |

4 ¥ ug TEy foe #, g% daete #7999 F |

5 IEA A7 qiaE H e F AT 23T FX U9 &9 W Faw
Ead

TragHe F feefie #e=1 (Delete a document)

1 wrEd ¢ 9 fFos ¥ |

2 e o) fFEE #W |

3 3T HEA B ge A AT efie/eemr wmed € |

4 HEA 9T 3e-fFdAT HeH, Aiewe Hig # § Refte F 797
Ead

3 T (Create a template )

7T T 3/ AYE F SAgHe A9 AT RO, o wewwe, T

et et & RN % AT YEEI EEY aA € Al 99 el

F €T | 9 T § ATk oG | AT &F TS T8 AT AT

q FAT & STE SHHT ITART F T | T SEIHE T8 & AT

2, 7 STITE a7 &, AT fh &g 7% Ieic FEATES i € Ia9
AT FX |



I 89 FIAT (Save a template)

1 T wEa # dae & TY F 49 F9A F o, ®Ed 9TX
T FF, 8 T W s w1

2 FEY 9T I A fFaw F AT Afted 2016 T8 7 7A-
PC ¥ 5t = o &<t | (Fig 1)

Fig 1

[I:I Computer

=  Add aPlace

Account

Options

3 @I AN 91 § FIAT SFAS HT ATH ET B

4 gava (3R®) Tvee F fod, &9 uw TEy foawe § e
ATEeH X o wY | JerEe & fod 98 # 9¥ e 77
farw #% | (Fig 2)

7S ST STagA< | Wbl &, AT Wohl g ees SWeie ¥ farerah ¥ |

Fig 2

File name: My new template

Save as type: |Word Document
Aikions Wnrd Document
] * Word Macro-Enabled Document
Word 97-2003 Document
Word Template
Word Macro-Enabled Template

Word 97-2003 Template

AT AT AT FEEH AF I HleeT § Tl [T |
5 @7 T fFaw # |

T - TE TIR F (o TR TR TATHAA THATH Hl

T &Y AT FT TEY & (e wY BT ATQA A T g

TET FY TE 98 T T F At A9 Rt "1

TATH AHI S H A & | Fg W T e A

Y T I I Fiee # @3 (R & Jdt g

T AT FIEA = T T2 e F390 q ST IW Gleg?

H et e T |

e § @unita® (ufer) ®wam (Edit your template)

AT T ATLE FLA & o, BT AT, ST TGATT ST HEAT

A & T8 FL UL IFTcieH F AT FC S |

1 f&= =% File > Open |

2 F¥geY W fFa® #¥ a1 {E-PC X 9w fFos &1 |

3 FEH AR TqACH HS § AF A7 AL TEAGHCH &
q=T & |

4 FTee X fFow wea, e o faesw w7 |

5 o 959 FIA € 98 L UF 89 FLh Wl 9 FY & |

FE - 2 : FUTANEA, TAA AT TAH & (7 ATEr FFE e A

1 File>Options>Proofing>AutoCorrect Options 9¥
faers &1 (Fig 1)

“Auto Correct Options” &= 9 fFT® ®<r |
Auto correct tab 9= fAw aTRT FT =TT FI |
«  TWo INitial CApitals 3% =T |

« I # Tedl e & Capitalize #2t |

2T A T T8l 37T H Capitalize F | (TF AT TF Al
& fam)

« 3T &1 T * Capitalize #t |
CAPS LOCK #T #T stresfers waT &t 3 &2t | (Fig 2)

A&, & wE. A .L.u|. : Fur (NSQF @2 - 4) - 31914 1.6.34

Fig 1

(yenery }..'(ﬂ\ . )
M Lange now Word correcls and formats your ted

Preohng hutoCorréct options

Change how Word cormect and formiats tot a3 o type [ RutaCorrectOptions, J
Typoqraph {ﬂ'

When correcting spelingIn Mcrosoft Office programs

Advanced
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AutoCorrect Tt # T% et 1 FAtet, g5t a1 Riere w7

Fig 2
AutoCorrect: English (United States) ? “
AutoFormat | ) Actions
AutoCorrect Math AutoCorrect | AutoFormat As You Type

] Show AutoCorrect Options buttons
Correct TWo INitial CApitals

[+] capitalize first ietter of sentences

@ Capitalize first letter of table cells

[¥] capitalize names of days

Correct accidental usage of cAPS LOCK key

Exceptions...

[#] Replace text as you type
Replace: With: (@ Piain text

© e

Formatted text

| e} €
(r) 4
(tm) =
i e |
Delete
Ei Automatically use suggestions from the spelling checker
[ oK Cancel

AT FT0T SIgER F UF U F ASA
1 AutoCorrect tab &t sTrsit |

2 Replace box & T TH I IT ATHATI FI ST ATT FFIX
TAd SET AT TAd dd+T FXd & S° eZd & | Iam:
usualy =T=T FIT |

3 With box # 315 &7 &t ad+T 2137 F¢f — 3aT: usually
TET FI |

4 Add 7 fFE #:20 |

G FT AT #§ A gAr AT With box & T Gedt @y
el

uF Uedl &t fRRfere #war €, =it & srw g MY Delete
[ExEEzall

& - 3 : AW Ht T HX T FA (Create and run macros)

qeq | Akt R*E # (Record a macro with a button)
1 View>Macros>Record Macro (Fig 1) ¥ fFa® #3t |

Fig 1
TR Switch  [Macros
Windows ~ -
! By View Macros
?_j' Eeccrd Macro... 1
bng

2 et % forg uw 79 @y = | (Fig 2)

Fig 2

o
Record Macro

Macro name:
MyMacro

Assign macro to

2 o

Store macro in:

Keyboard

All Documents (Normal.dotm)

AT STRIAS ATT AT a7 7@ & IAA TH WA FT TN FA &

fore, gfafeaa @< & am & “Store macro” #Fxar € Al
Documents (Normal.dotm).

3 I WHL T * (T ST AT Th G2 9G¥ {Fow He,
Button 7% &% ®¥ | (Fig 3)

4 731 %t it fFaw w2 (Normal.NewMacros.<your macro

name>), & AT F© FeT WAT & fRY Add R w |
(Fig4)

Fig 3

Fig 4

WP, Cestamas th

P p— e -
m 3 Unde

o> ]

I _:. Normal.NewMacros.MyMacro

162 aE &, & wE. A E.um. : T (NSQF @ - 4) - 3919 1.6.34



5 Modify °¥ f& <t | (Fig 5)

Fig5

Customizations: Reset ¥ U
Import/Export ¥ | ;

6 e TAT AT, | AW AT AR & 239 fHrw R COK’
o¥ 3t ae faew & | (Fig 6)

Fig 6
General [

i=%] Customize the Quick Access Toolbar,
Disglay b

Choose commands from Customize Quick Access Toolbar !
Proo 1
rooling Macros For all documents (default) &
Save
Language | <separator ‘ S

k ‘% Spelling & Grammar
Advar

Al Modify Button ? X [New
Customize Ribbon [Norme! NewMacros.Macro7
Symbok:

Quick ficcise Toolbs &0001 ! tOERTE A
Bl .Dﬁ‘gjﬁancr1)é
) ava@AaflPrEAY
Trust Center 1Y E v

[ B

OF g

(m m EEE =mgl
B0 SOMZembéws
D REEE=0E %
BB XvEOMT D i
DIELEENSAWES v
Display name:;  Normal NewMacros.Macre?

ana

Add-Ins

Vhd s

[ Show Quick Access Toolbar below the Customizations: | Reset

Ribban Imgort/Export

(114 Cancel

7 g s R AR s s U e e s B &
ferg “commands or press the keys” a¥ fFo® &2t | aS
TR foFereh Y asegia ®t e wear @ |

AT AT FTYHT ARl RS w2 o o 9 1 s
FH THE I | AHIE AGH @ T T B R T
Far |

A& & A A LA, : Far (NSQF @ - 4) - 3131 1.6.34

8 R=fé g w37 * forg View>Macros>Stop Recording
¥ faes ¥ | (Fig 7)

Fig 7
e by Side i
= 1=}
15 Scrolling ) D!
Switch  Macros
¥ NG hor Windows ~ -
! Cly View Macros
B Stop Recording N
lle Pause Recording i’

9 #wht & forg @eT Quick Access Toolbar # f@Ts qear & |
(Fig 8)

Fig8
@E YDA
HOME  INSERT  DESIGN
Lﬂ D E\ [Z] Outline ~ [V] Ruler
s
= [ oraft

7 | Gridlines
Read | Print Web

PAGE LAYOUT REFERENCES MAILINGS

Q E:) [E] One Page

B [ puttiple Pages
Zoom 100%

Mode Layout Layout | Navigation Pane ‘) Page Width
Views Show Zoom
L 1 ® 1
04422500248

10 Hst # TF FA % forg g = fFaw #L | Fig 9 § Foriam
% s e fim = |

Fig 9
BE VDN
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS
B [:I “'\ [E] outline [ Ruler Q [’_") E] One Page
| I e -
=% 5 pnt Gridlines ED [0 Multiple Pages
Read | Print Web Zoom 100%
Mode Layout Layout Navigation Pane I Page Width
Views Show Zoom
1 %
L &4 1
04422500248
04422500248
04422500248
163



A, & sEaie. (IT & ITES)
w1 (COPA) - ¢ safi stweae

v e 1.6.35

MS =€ s w3+ ®da &t (Mail merge using MS word)

I T AV & A H AT HA § qEH & A
o BTH AT TATHT

o IR T H AT LT FIAT A I JTet H AT FE TRET F2AT
g% AZenT | personalize letters #¥= % foTT mail merge #T1 =T ®31 |

sawmFae (Requirements)

HHATE [ STHTOT[ATEA

o fave® OS X MS stifear 2007 % @ us =ferd PC

-1 No.

af¥am (PROCEDURE)
FE - 1 @ GH dAeT T T

N
J
i

1 Mailing — start piail ® IR

Merge -

stEr % Fig.1 ® fRamar o 2, w6 &g = i)

Fig. 1
—
- VIS W
. _f/ Home Insert Page Layout References Il ailir
| [ | -—-.:' = : 3
=] = ey g8
Envelopes Labels | [Start Mail]  Select Eclit Highlight
Merge ~ |Recipients ~ Recipient List || Merge Fialk
Create — __1 Letters L
j LH ®) - 6 & =l E-Mail Messages
ary g
E =3 | Envelopes... -
=il Labels.. [—
! j Directory
= : Bormal Word Document
iw)| N
£ __:_I Step by Step Maill Merge Wizard...

2 Letiers T AT St i O R

3 = fear w97 (letter) =ET FI
FROM

TO

National INSTRUCTIONAL media institute,
CTl campus, guindy,
Chennai 600 032

Sir,
We trainees studying in ITI, we need to know the

pricelistoffewtrades for purchasing course materials
like

1. COPA 2. FITTER
3. WELDER 4. TURNER
5. PPO 6. MACHINIST

7. COE AUTOMOBILE (BBBT & AAT)

Sir Please send us the price details and the discount
details, which will enable our friends give bulk orders.

Thanking you

T - 2 : ot arelt @ g (list of recipients) F TTEY #X Y 9T At w1 g ulew

B

1 IMailings— & g+ sfte ser fF Fig. 2 &

Select
Recipients -

fammar 7= @ "type new list" T FX |

164

stat f Fig 3 # femman man &, &9 w2 "New address
list" fareet fenir




Fig. 2

Ca

_ﬂ" Home Insert Page Layout References | Malings

=158 B R

Ervvelopes Labels || Start Mail|  Select Eclit Highligit
Merge - [Reapients = Fecipient Li'-.r/ lerge Fields
_ (Create E Type Mew List.. ¥

H9 5 &Y

3 ] Use Existing List...

I S

: _G_I Select fram Outlook Contacts...

H
ol

(L]

Fig. 3 FNewAddress List l g a8 I
Type recipient information in the table, To add more entries, click Mew Entry,
Title w |First Mame  «|LastMName | Company .. «|Address L. «|Address L. vlCiiy
* | I ;
| bewerry | | Eind.. ]
l Deelete Eritry l l Customize Columns... l l Ok ] [ Cancel .
A

2 "Customize columns" & 9 |

A "Customize Address list" faret & av feasft| sar &
Fig. 4 & fe@mr = & |

Fig. 4

Customize Address List |

Field Mames

.
First Mams
Last Mame i
Comparty Mame o
Address Line 1
Address Line 2
City

State

ZIF Code

Country or Region
Home Phone
wWiork Phone
E-mai Address

=
fal
fwl

i

Renams...

- Moy Cown

l O l | Cancel J

3 title" # I X "Delete” ¥ fFw FX |

Trgew fe (delete) ST 3w &ie WX fe@wm "Are
you sure you want to delete field "title"? s f
Fig 5 & fammar an € "Yes" ¥ fF® #¥ |

Fig.5
Customize Address List Y [®] & |
Figld Names
ﬁ A [ s
First Name —

Last Name @
Comparty Name =

Address Line 1
Address Line 2
City

State

ZIF Code

Colntry of Region
Home Phone
Work Phone
Microsoft Office Word [ %

'o Are you sure you want to delete field Title' # Any information contained in this field will be deleted as
o el

A&, & wE. A .L.u|. : Fur (NSQF @2 - 4) - 31914 1.6.35 165



1 R * T ke ®2 "Country & region”,

"Home phone", "Work phone" ¥ "Email
address"

2 Fig. 6 % smadt weATEw Uevd g fawst R wd
&=

Fig.6

Customize Address List | ®] R’ |

Field harmes

First Mame =
Address Line 1
é?jdress Ling 2 Delete

ZIF Code

2=
Fal
fal

Rename...

1

Motve Up

0K

Cancel

4 OK &t gart =¥ 4 f& Fig.7 # fRwamar w=n & =i var

EEECR
Fig.7 New Address List 4 &3
Type recipient information in the table. To add more entries, click Mew Entry.
FirstHame «|Addressli. « |Address Li. | City - | ZIF Code -
5 - . - !
| mewEmmy | | Find.., |
l Delet Entry l ICustomize Columns... I Ok, l l Cancel
: b

166 IE &, & wE. A ..ux. : wur (NSQF @< - 4) - 371w 1.6.35




5 warfe Fig 8 % fe@mar = 2, "First Name" & == "HARI"
T HY |

Fig. 8

rNew Address List 2 ® | 23
Twpe recipient ir%nation in the table. To add more entries, click Mew Entry.
Firswa‘ry v |Address Li. | Address Li. | Ciy v|ZPCode  «
E S : L - .
[ News Ertry l l Find... ]
[ Delete Entry l | Customize Columns... ] l QK l [ Carcel ]

£

6 M AW ¥ AT F oI 97 q199 T27 FT At HiaAF T

7 <& % Fig 9  femmar mar &, Fi=r Ry 1w et &t g &

TEw & forg "TAB" 7 (key) it gaTd AT AISH Fit U5 fFa® foT, Few 6 & qrE |
I
Fig. 9 New Address List . I s &8 ]
Type reciplent information in te table, To add more entries, click Mew Entry,
Firstiame w|Address Li.. « [Address L. « | City « |ZIFCode
|__|HARI 3RD CROS.. ADYAR CHERMMAL 600025
|__|JOBIN 151, PARK .. MEAR ARP.. MNAGERCOIL 629004
|| GIRIHARAN  CLASSIC H.. SHANTHIC.. HOSUR 635109
E‘ YA G1, RAJAIL.. [riiNen{s Il COIMBATQ.. |64103C
| || VIGMNESH 15, POOKO... THARAMAL.. TRICHY 620008
| Meweony | [ End, ]
[.:Q@J@.t;e;_ﬁmtrx. ] |:.9w2@3mlzg.-:§@lum.r_?§gz- ] l QK ] [ Cancel ]
: ; 2|

8 OK = fass #¥ 31T st & Fig 10 & fRwmam mar &, =

"Save Address list" T« diwe @ |

10 &9 (save) T fFas #< |

9 "MAIL ADDRESS" & ATH & %13l AH 2157 X |

A&, & wE. A .L.uq. : Fur (NSQF @ - 4) - 319+ 1.6.35
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Fig. 10

“5] save Address List

. | ¥ | | Search

Favorite Links

Ei Documents

More »»
Folders o
__S‘: etwork o

Q Control Panel

E Recycle Bin
chemical 13-19 J
DOT-15-2-2010
Figs

-

Leather Garment:

ew Folder

. hew Folder (2) o

-

/

Date modified Type Size Tags
= pAIL ADDRESSL.mdb

V4

File name: MAIL ADDRESS.mdb

-

Save as type: | Microsoft Office Address Lists (*.mdb)

-]

= Hide Folders

Tools - [ Save- ] [ Cancel ]

stat T Fig. 11 ® Raman o €, e 220 9 e
Tt @

11 OK 9¥ foeres |

Fig. 11

WX

Confirm Data Source

g;endaﬁ source: IF
-
| MS Access Databases via DDE (*.mdb;*.mde)
|MS Access Database via ODBC (*.mdb,accdb)

] show al |

T R ¥ UEd & Hiv(g A9 F gE TSI g
T FA F o, FIH 12 F AgER =T |

12 Fig 12 & Ram 7u E«tT aFg & & ¥ e =,

E
|
g
Malling —  Select —

Reaments -

~1 - Uag Exiglng L.

13 w| F fFAE wL
[ pen_[]

et

M - 3 : Bulk #3fent # personalize letters % T mail merge #1 s=T #3t

TR 1 : YT T TgHeE oA F (Prepare your main
document)

1 Mailings tab #, Start Mail Merge J7 & Start Mail
Merge>Letters.(Fig 1) &1 =9+ &< |

Fig 1
Insert Design Layout Refe: Mailings
5 =
=8 [as

Start Mail Select g
Merge v | Recipients ~ Recipient List | Merg

[7] Letters

2 E-mail Messages

R Write
ROEEREEY
E1 Envelopes...
TR Labels...
l__-l Directery

|ﬁj Normal Word Document

m Step-by-Step Mail Merge Wizard...
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2 I # q&TT W 3T F (I, 3@ THhW) O sto "9 F:t
ST =R # | (Fig 2)
Fig 2

January 1, 2016

<Insert recipient’s address here>

<Insert salutation here>

Thank you for being part of the community’s conservation efforts. Because of your contribution of
<insert amount here>, we are pleased offer you a <insert amount here> discount the next time you visit
our online store.

Sincerely,

Keri Mills

TROUT 2: ATYHRT AT AT HeAT F2t (Set up your mail-
ing list)

AzforT foree STt 2T T © | 98 UF vaEd SEHie, ASeqdF
FTeqed & SEALAL! U0 Serad A7 UF Tihd oar gt |
md gt Rae gid & Sew a8 SIeart ddr @ sas gy
T @ HI foraw AT 22T FeA & forw |

feoefy

« R A* qF RwIfent fore TE 2, A0 AW W
FIQ W TH a1 qEQ E | FEA ASA qHAT TE FRA
¥ qeat gt 31 RFE wuE w9 AT A T2
a # Tl av add F |

o TFEA BT F T Fed qWA, T FrAfeaa
# & ZIP FiT 1 Tiew FiT FOW T F S0
e e s @i W g T ge 9 |

¢ I AT ATSEIH FILH Ht TUAT HLAT AT £,
giwafraa Fife & aeegs @t fwe email
program ¥ |

T 3; T e T W AERT g & R fifw

(Link your mailing list to your main document)

1 Mailings 2 #, Start Mail Merge 37 #® Select
Recipients 3%, fr us faswer g | (Fig 3)

Fig 3

Design Layout References

P

Select
Recipients = Recipient List
K7 Type a New List...

[C] Use an Existing List...

N

B3 Choose frem Outlook Contacts...

2 = & & uw #2
o AzforT fore 7€ €, Type a New List g s us
FAE |
ar
SR ATTH WI(oWT GHI UF THAA Se9iie, THd Seed av
A THR FT 3 F13 € a9 Use an Existing List Ft
At | s fore | arss # #fT Open g1 |

2l

3R AT SATISIF AT TSI ¥ T &, Choose from
Outlook Contacts &t 1 |

3 File>Save as #t I |

4 ®EA AT G H, TF BIEA AT BT w4 Y Save T
T F |

TANT FIR aren gt & udie w74 (Edit recipient list)

qaa fog AT gt § e aq a1 qied F<7 & forg “Step 4:
Add personalized content to your letter.” a¥ @gT | 30X
ATT T IT AgT AT T&d € : ISR F oy, T uF dee 20
miles & 3(3¥ &fte F¥ T8 & a9 37 UF fheex ZIP Code a1 7%
wieeer Fie, fore B A B F 00 @ T A |

Edit Recipient List (Fig 4) %t g1 |

Fig 4

Insert Design Layout

Start Mail  Select Edit
Merge ~ Recipients ~ Recipient List
Start Mail Merge

Mail Merge Recipients SIaTT a1 & 8 U GHT FT
T S8 ST FEe AT AT & W% 9T U 99 FTY |
(Fig 5)

Fig 5
r
Mail Merge Recipients

This is the list of recipients that will be used in your merge.
Use the checkboxes to add or remove recipients fromthe n
Data Source | [ |Last Name - | First Name
EventMailinglistx.. [¥ Anderson Nancy
EventMailingListx.. [ Basalik Evan
EventMailingListx.. [ Carbonati Cyril
EventMailingList.x... [T Dixon Andrew
EventMailingListx.. | Dow Jane
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Mail Merge Recipients SEETT a1 ® ST &< T list
F TRFEd Fe F forg fawer € | 3t & stftes are swwT G
T famer & AT aSe Y fove & fheew #%F @ & AR
X 9aT ® @I F % | (Fig 6)

Fig6
Mail Merge Recipients 7 X
This is the list of recipients that will be used in your merge. Use the options below to add to or change your list.
Use the checkboxes to add or remove recipients from the merge. When your list is ready, click OK.
DtaSooe  [[7 [Ladthone  y[Fritome  o[The oAl |Gy
< >
Data Source Refine recipient list
EventMailingList xisx 8] sor..
19 Fiter.
¥ Find duplicates...
E} Find recipient...
[ Validate addresses..
oK
)

T 4: FIHT A A A..Fd Fwee &1 Aiww (Add person-

alized content to your letter)

1 Mailings tab #, Write & Insert Fields I # Tgd =T &t
I 1 (Fig7)

Fig 7

References

Mailings

- I=n o
] =1=]

=

. =5

Address Greeting Insert Merge
Block  Line Field ~

Write & Insert Fields

Di Rules ~
T & Match Fields

2 Insert Address Block ST« T+ ®, T% ®ME< =99
F forad araswdt 1 A9 S ar e d e a=2 |
(Fig 8)

Fig 8

Specify address elements
J Insert recipient’s name in this format:

Joshua

Joshua Randall Jr.
Joshua Q. Randail Jr.
Mr. Josh Randall Jr.

Mr. Josh Q. Randall Jr.
1— Joshua Randall Jr.
Insert company name

\¥| Insert postal address:
Never include the country/region in the address
Always include the country/region in the address
@) Only include the country/region if different than
United States

J Format address according to the destination country/re

froroft: freg # ww o S @w @ REE ww s Fmm
#, Preview Results It | Next p or Previous 4

3 OK#t ¥t |

R sew &t st 2o Ena & Reaw | gargd |
4 Write & Insert J7 #, Greeting Line F=7 | (Fig 9)

Fig 9

References

Mailings

r“:\ Rules ~

= =N E
7 == Q% Match Fields
hlight Address Greeting Insert Merge .

Block Line Field ~ Update Labels

Wirite & Insert Fields

5 Insert Greeting Line ST amed &, 3T S ®Ee
TEANT FEAT AR & I8 g |

6 OK &t Zo #Iforg dex # Al &7 6 F3A & oy |

7 File > Save to preserve the letter 9AT (3aT. T8 T&IX 8)
you're creating for the mail merge. (Fig 10)

Fig 10

January 1, 2016

«AddressBlock»

«GreetinglLine»

Thank you for being part of the community's conservation efforts. Because of your contribution of
<insert amount here>, we are pleased offer you a <insert amount here> discount the next time you visit
our online store.

Sincerely,

Keri Mills

ATTHT A5t fored & @ed § FEW SHHET B 50¢ H¥7 &
foru, ug w3 Ol fheeT s @wT § d@ |

7 fhee At 1 geaTa w3t (Verify merge field names)
gfvfeaa Fifom & a< soer foee & 99 % AT @i ofar 21

Mailings tab #, Write & Insert Fields 7 & #= fheeq &1
a9 w4 |

e : THE qAT TF STAAWT AT R AT Uk g
THRIAE H TAT ATH | AT & (o0 o e, o
T fhes @it | & |

1 B9 & SIANT a1 |, a3 % (e & a7
fore @ fearE wear &, struer Az fore Sar &t & Fow
ofiet R % forg @ & forerd & 1 (Fig 1)

T : TIAWT I | FTH 2 | 6 Frew 7 faRmm
Rare & amar A &1 g € | I Fwre S 9T
T ETE | TF FIAH 09w /Y fFaw 2, 39 9 &
o aaam e |
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Fig 11

TN Azteh Foaide

In order to use spedal features, Mail Merge needs to know

A==

4 Page Layout tab (Word 2013) ot Layout tab (Word

2016), IXRITE T St g =y & 99w #< |(Fig 15)

which fields in your redpient list match to the required fields. Fig 15

Use the drop-down list to select the appropriate recpient list

field for each address field component Indent Spacing
Courtesy Title Title - =% Richt: 0" = 5 -
First Name First Name E’ A =¥ Right utl it e |Ept o
Middle Name (notmatched) [&] |~ | Paragraph [
Last Name Last Name [;_l | W

1 A= & o A

feEm T & AT F et Aot fove e A 7 Fwre
ol ST et Rt & forw IuT &tar € a9 #ar €, a9
TS A F |
T

X (not matched) &= 7w & fR@TE gar & &t o9
FTrH I ATIHT ST @ & foeq 7t 3ufie 8, a9 o =
fires arem T &t gar 5w s AsfonT foe et &=a |
fohee AT F FAT | W ATETAF B At s |

2 OK¥ |
¥ A & ® wHE w4 (Format mail merge fields)

B, qIEST AT AW Frerd T Wil H 5o F fog, a= fes
AR AT AT FAT FgAAT AR & HA

1

Mailings tab# Preview Results I7 # Preview Results
FEAT, Fote TROMH aTTq ATIH ded # A 71 (heed Hi
fer w1 & fom |

Fig 12

M 4
7D Find Recipient
[} Check for Errors

Preview Results

P M

.;@>

Preview
Results

2wt & AT A g | (Fig 13)

Fig 13

«AddressBlock»

3 Home tab ®, ®1=< ¥ %< & ATHE SBF T T=i0

FIAT Ted €, gAr | (Fig 14)

Fig 14

Home

Design

Calibri(Body) ~ |11 ~ A" A Aa~ #Ao
B I U ~abex, x* [A-%. A -

Font

Roofi: FifF a2 seTw =& # W UF @A F TH
EE SR, AT AR F AT W G R FIAT
Elengau il

=0 5 ; @q #t g i e #wr

1 Preview Results gﬂ’f f5T Next p 37 Previous 4
record button #t It | gfafraa # & forg &% a7 =i
aaT et g ' @€t fTme |
froeft : e =1 g% 't 9= F foU First Jqrecord

button =1 == ¥ ¥ fore #1 siw 9 & forg, Last
Pl record button %t Tt |

2 Finish & Merge > Print Documents &1 ==7 &< |
(Fig 16)

=P

Finish &
Merge ~

Fig 16

cxry ;
Ly Edit Individual Documenis...
M
g Print Documents...

[*. Send Email Messages...

T 6 : ATIHT AYRAaT A FT AT FT (Save your person-

alized letter)

AEA A STAIAE AT FIA A, q€ Ao fore FY A gor
TEdT & ATlh I8 =T Agfort & forg o 2t |

SATTHT HIA AT STHGAE Hl TTANT FHAT

+ WEA AN STHAC F @At gAT AT q€ Fuar & F dAae
1 w® |

AT A STRgHE | ATTH a7 agei & forg

.« HI A eEgHe @rar e Edit Recipient List # are
foheex 1 JAT ST ofers seEy & g |
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A, & sEaie. (IT & ITES)
w1 (COPA) - ¢ safi stweae

™ 1.6.36

¢ - ufeaiim strer (vf=rm #39 F fawer) (Word - Publishing options)

IR FH TVE & STl # AT FIA A HH & 0
o AR F TF arferT aA

o It T ATt Ht WA FLAT TS ATHI ST

o EIFW FHt TAT AT AU FIAT

+ ot foent § eEwfew @

o FHFATH, FHE, AHIFHIOT, FH NI T FEACH FHE FEAT
o AfenT Td AR AR gree gRfEE wit At |

saw+ard (Requirements)

HHATE [ STHTOT[ATEA

uF afad PC favet sttuw ud
MS sfifesr 2007 afed

-1 No.

FE - 1 : IAA ATE Fe AT FT 3 FATT

Fig 2
&l l Table of Contents Options ? x
T ATE Fe &t AT & o FITAT FHC O T 1 I S | Build table of contents from:
Mistylesi
e & T 1> T AT Frered T AT F0h > FHew Ead . medoeia
A -~
- . . o - - Body Text1
AT Frogd g | BhIF T 3T A1 Frowed SHANT a1 UF fa@rs
o ° ¥ Heading 1 1
2 | (Flg 1) v Heading 2 2
Fig 1 v  Heading 3 3
Table of Contents ? X Heading 4
Heading 5
Index | Table of Contents; Table of Figures Table of Authorities v
Print Preview Web Preview QOutline levels
HEAdING Lucuueeeeereeneeeneeecrenanans 1|~ | [Heading1 A [[] Table entry fields
1 ST 1117 3 SR 3 Heading 2 Reset Caneel
Heading 3......cccoouieniniicannins 5 Heading 3 —
v v
E Show page numbers @ Use hyperlinks instead of page numbers
i Right align page numbers Flg 3
i Tab leader: | ... v
Table of Contents Options ? X
General
Build table of contents from:
Formats: From template ~
Show levels: |3 $ Styles
Available styles: TOC level:
. = "~
Options... Modify... Heading g
Cancel v  New Heading 1
Mew Numbering
AT T T fae® Y | T AT Frered ATTT STAANT J1F New Paragraph Heading |
. Normal
Ao |qrae gwe g6 | (Fig 2) i
Mormal (Web) U
1,2, 3 @& TOC &9 3= &t fIcfe &% | Outline level
Uutlineg jeveis
: — - Table entry fields
Fig 339 td TOC @aaf 1 &< F¥s OK ae u¥ e #¢ | [ Table entry field
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A ATH Feed SAANT aiaq &1 e ey ud 3 sy fawed,
ey dae (FY) 0" FgoiT 3@ | (Fig 4)

3% e o faes #2 | Fig 59 o9 3w vt & 397 fewen fFars
& |

Fig 4
Table of Contents ? >
Index Table of Contents | Table of Figures  Table of Authorities

Web Preview
New Heading ~

Print Preview
New Heading......ccccoiiiimmiiiiniinins 1|

v v

B show page numbers B4 Use hyperlinks instead of page numbers

B4 Rignt align page numbers

Tab leader: | ... ~

General

Formats: From template ~

Options... Modify...

Cancel

FEE 2 : TAA ATE Fowgd Ft THE AT FEATEA AT

S AT 9E | Tq ATF Freaq a1 o, IHE d1E a8 Ha faadr
& I AT ST ST 98T A%a & | IITewwr & ford, 91 Asfrset
T Tt &, TR WA FeAT, b 2w =< fRmm € 3 3gerr
TF U UF O &Y & i | S{eS argd Q@M € AT ALl T8
AT |

I ®He F31 (Format the text) (Fig 1)

Fig 1
Contents
Heading 1.....c.ccnninmmmnnrmmmsnmssnnnninns 1
Heading 2 ......ooviinnnsessnnninssnnnne 2
HEAdING 3 w.iouvirsnssrsmssssssssisions |

Contents

| (T TTS EUR——— R
Heading 2.......ccvvevavecisvmnimenesens &

Heading 3

=t T=it 1 @¥ sg@= (Change the level of an entry)
(Fig 2)
Fig 2

Heaaing 2...cccsuruasssersasasesiases

[ [ [T R —

!

HeAAING 2.ciiiiiciusissisivisvisssavi]

Fig 5

DESGN  PAGELAYOUT  REFERENCES  MAIUNGS  REVIEY  VIEW

K x Me B CLEE.EEN Y
;LR P EE T ot AaBli 1 As9b0 AsBHCD AqBbedr Asdbce AgBol
Uvix, x AW A E=== 120 B0+ thotyTe. [NavHe. | INewNo, TNewPa, SNomal TNoSpic., Hesding!

Fort G Palagiaph

1 1 1 i i H §

Content

Task 2 : Change the spacing between characters ...l

grearet wreY AT (Add dot leaders) (Fig 3)

Fig 3

Contents
Heading 1
Heading 2

Heading 3

Contents
Heading 1..cueeeveevrrenme e a—— 1
Heading 2......ccoeveeeueerineanns . 2

Heading 3 ...cccoee corinssssssnsassnans &

dae (w) fFa= gt 7g Fga (Change the number of
levels shown) (Fig 4)

Fig 4
Contents
Heading 1
Heading 2 2

Heading 3

Contents
Heading 1 1
Heading 2 2

IqA AT Fe F ANSE I (Change the layout of
your table of contents)

1 Rew % Redwa 2o 9 3ot 311 e e T fFras # fe Table
of Contents>Custom Table of Contents 3+ | (Fig5)
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“ HOME INSERT DESIGN PAGE LAYOUT REFERENCE

Tj Add Text ~ 1 m—_‘ Insert Endnote ‘{_‘L] ,':T—', Mar

= [ Update Table AB] Next Footnote ~ r—l._‘; Styl
Table of Insert _ Insert €4 Bibl
Contents ~ Footnote = it Citation~ -0 ™!

Built-In ions & Big

Automatic Table 1

Contents

Type chapter title (lewel 1) : b o 1 a

% More Tables of Contents from Office.com »

[E] Custorn Table of Contents...

&/

E‘;‘( Remove Table of Contents

2 Table of Contents STl s & w@HT ¢ qREdT
w2 | Print Preview ¥ Web Preview &= @ 24 at
&9 fa=g oead € |

+ B UF U HIX IAF U9 AW & o9 e e} av &6y |
gTeT ATET & U &+ & forw, Tab leader foe =t fFos
T e gTes ared ¥ foets &2 | T U a7 ofie¥ &
AT AT IH ST &1 L a¥F 7 fAwren A7 fE o =@
e Tt | (Fig 6)

Fig 6
Tab leader: ... |:|
(none|
General
Formats:
Chuomiis Launles k] =

«  ATIH A ATH Fee F 94 fa@mEe aga+ & fag, For-
mats fore o fFoas w4, v S w@e o =Ry
fae w2t |

o ATYFT I ATE Fedd U TSIA [FHAT TAT T F T==ar
i a2 & o' Show levels & &3 fhe fohaem d&=r
& T ATIHN FTRT 379X fFos w0 | (Fig 7)

Fig7

Table of Contents

index | Table of Contents | Table of Figures | Tabie of Authorities

Print Preview Web Preview

[ [=F:Te [157- B RN 1 = Heading 1
HEAdiNg 2 vevveervereeeerereseeseveneas 3 Heading 2
[¥] Show page numbers V| Use hyperlinks instead of pag

[¥] Right align page numbers

Tab leader ... E

General
Formats: From template B

Show levels: B t}

Cex 1

fRuoft : @ deW | “Levels” 9T u® @@ Hi
Hefia ®¥ar & | g7 s & fow heading TR |
fFT =7 shid=® & Su-wwnt # Heading 2 Tfaw | sar
AT TR a1 ATTHT 9 ATE FreeT AU A AT ATr®
ITEE 7@ qFd & |

3

OK #t fae= 1 |

ATTHT I ATH Fiw | dqqe &t GHS w0 (Format the

text in your table of contents)
ATTHT ST ATH Frevad H THEE H [@@TE TR agel & forg,
T ATH Fard W B¢ T &¢ | W13 [ geav |

1 Ra %1 References 27 # Table of Contents>Custom
Table of Contents ¥ f&® #31 |
2 Table of Contents sz=m s & Modify 7% fFs
#X7| 3T Modify Few ot &, & Formats %t From
template # <t | (Fig 8)
Fig 8
Table of Contents ? 3¢
Index | Table of Authorities
Print Preview Web Preview
Heading 1.....ccemrreneeeesissnnssannennns 1 - Heading 1 -
Heading 3 Heading 2
Heading 3. 5 Heading 3
[ show page numbers Use hyperlinks instead of page numbers
EI Right align page numbers
Tab leader: | ... v:
General
Formats: From template I
Show levels: 3 =
Options... Modify...
Cancel
3 Styles foree & 117 i AT T Fa =ATed & I fFas FT
fi5% Modify = & £ | (Fig 9)
Fig 9
Style ? >
Please select the appropriate style for your index or table
entry
Styles:
TOC1
M TOC2
M TOC3
T TOC 4
M TOCS
M TOCE
M 1TOC7
M TOCSs
T TOC S
Preview
z 20pe
Font: 10 pt, Bold, Space o~
Before: 12 pt
After: 6 pt, Style: Automatically update, Hide until
used, Priority: 40
oK Cancel
4 Modify Style STaTT aTad #, ®IRATST § a1 3fosq

af¥ada #, f OK fawr® #¥ |
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5 ATIhT Cael 1 o | T &¥ A TP HA & forg =<y
3 AT 4 greed |

TETHE | TAF 0T AT ¢ ATF Frewe B AISC FId TH7T
T g FEHATEAIT H J1§ @ & |

et & =R F 97w (Change the level of an entry)
HATTHT STl ATF Freve H Uil HT @ H TRadT Hed & forg
AT TTEHIHE F G AT H TR &7 9 @¥ & aRadT & |
1 @ heading # daeM =Ted & I8 IX fFo #40 |

2 Home ¢ #, Styles y7 #, o 2fewr ww =Ry 39 w®
e #%7 | (Fig 10)
Fig 10

REFERENCES MAILINGS REVIEW VIEW

| S Yoy

=% &% N T aasboec AaBbCi AaBbce AQ
T Normal Hsaﬁgl Heading 2 Titl

T

il

[1l}
|

Paragraph f Styles

3 References 2o @, Update Table ¥ fF@® =TI
(Fig 11)
Fig 11

HOME INSERT DESIGN REFERENCES

By [DAddTet: o1 [inset Endnote B ) Manag
= [l Update Table A8 Ned Footnote ~ [ES‘}"E:

Table of b Insert Insett ., . .
how Motes £y Bibliog

ontents Footnote Citation =

PAGE LAYOUT

Table of Contents Footnotes Citations & Bibli

4 Update entire table T fFo® ®¢t | fe OK fFas w0
ATYHT I AF Fe=d | e forgew wst (Add dot lead-

ers to your table of contents)

Tedl ST g H@T & @ § ATIH SHGHE § a9 Feeved S
TEe S &, 39 39 A ST & S§ 996 UF 74T a9l AT
Frewed forad aEt HHY Y T ey & I8 gree Al 7 |

1 References>Table of Contents>Custom Table of
Contents ¥ f&® #<T | (Fig 12)

Fig 12 o

INSERT DESIGN
*Eiﬂ =) Add Texe - AB 53 Ins€
= [ Update Table AE Ne
Table of Insert
Contents ~ Footnote
Built-In

Automatic Table 1

Contents

Headine 1, -

Table of Contents
Type chapter title (level 1) .......iemiiciicreisinneend

Type chapter title (level 2)...........o ]

Tirne chmntn $ela flonl 31
[E More Tables of Contents from Office.com
E] Custom Table of Contents...

E;} Remove Table of Contents

2 Table of Contents =T st &, Tab leader fore &
greE are faswer a¥ fFs w<t | (Fig 13)

Fig 13

‘ Heading 3.....cccvciiinsannnrennsans 5

Tableader: ... =l
(none)
General |- -
Formats ‘ ‘
Show levels: 3

frEm™ duT @ &1 dEn af¥ad| # (Change the number

of levels shown)

ATIHT T 3TH Freed H & H AW RAdT B & oy
HiSET daer & fSrEw o w@Y o =@ § & vy wiowra
FAT & | 78 T4 & o0 UF Sier, afdd get asda! Tl &
& &= Hie JTEHET S GUTRA HAT |

1 References>Table of Contents>Custom Table of
Contents 7% fFa= =2t | (Fig 14)

Fig 14
FILE HOME INSERT DESIGN 1
EE} T Add Text ~ 1[G Inse
—'  [lupdate Table AE Ney
Table of Insert
Contents ~ Footnote
Built-In

Automatic Table 1

Contents

~Headine 1. ...

Table of Contents
Type chapter title (level 1)

Type chapter title (level 2)

Tumn chantar tiela Mleaanl 2%
I3 More Tables of Contents from Office.com
E] Custom Table of Contents... I}

E.x Remove Table of Contents

2 Table of Contents ST«T a1 @, Show levels o
# ST @ & @ 7ty I8 gAt e OK fFws &3t |
(Fig15)

I3Tew & forg 2 a¥ fFew F3 & a9 @+t <Re Heading 1

w=TEa a1 Heading 2 ®msa 5@ @ frm stmar 2, 39 ome

Fveved § TEHITT ST |

3 o yed € fF T HisET dae Feded H ageAT ATed €,
Yes ¥ fa 37 |

A&, & wE. A .L.uq. : wur (NSQF @ - 4) - 319+ 1.6.36 175



Fig 15

Index Table of Contents Table of Figur
Print Preview

Heading L. .ivansnsmaasies

HeadINE 2. asmpsssmemmsmmesmpessanes

[+] show page numbers
[v] Right align page numbers

Tab leader:

General
Formats: From template N
Show levels: 2 :[}

Fieg FIT TSR F TR HAT ([ F d& qiaa=
F¥n) (Edit the field code information (to change the
number of levels))

ST SATA9T FHHIUE T TANT H¢A & (oIg a8 AT AT Fleg &t
Z0¢ FXAT & | IITE & forg ST 31T o7 A% Add Fd € a9
TE U Hieg FHS FXAT & | 5 39T ATE Frereq I & a9 a8
TOC field #T 8¢ FEaT 2 |

T - 3 : UF 29 H AT AT AT FIAT

Teh gead & (Faw A o fawet & |-"1er o g 9
T4 F @ T, I & A1 T B & F gAEAE FAT | TH
T I % forg o S8 UEr H AT wed € | (Fig 1)

TOC # @ o9 @Y &7 §&T & IRaaT &3 & oy Hiee
HIE SR &t GUTET ST & |

1 Iqd ATF Feed ¥ s w0 BT Alt+F9 u¥ garen |

e FIS ATTHET FLAT e & a1 39 a<e foaTs qears |
(Fig 16)

Fig 16

_f[’i B :‘ﬂ' Update Table...

Table of Contents
{TOC\0"1-3"\h\z \u}

2 3erew e # e #Y geford | IS & oI o ey
gt @ g e wea & | “1-3" a9 “1-2” § aftadT & |

3 Alt+FO garert fhe & 2ol 3% Fraed TSi9Td e & fog |

4 ITA ATH Freved F AU FXA F ATIH TRAAT it 3@
a#d € | (References>Update Table).

3 Mark Index Entry SIamT am#q & 319 e &I dqrfed
F7 a%d & | (Fig 3)

Fig 3

Fig 1

Eﬁéﬁin gty
\{xEﬂamstheeMmm} 1

Crous eforares

T F 7T w21 (Mark the entries)

g w0 feE € & o4 9 3= | w= AT a9 i

fafed F3am, Al oo TRe ot F 0F HAT @i I

2o U RifRa sv awa & |

1 s awe gAa O o o Of S90S #3491 et
TE W 3¢ FIAT ATeq &, fFew w4 |

2 References 29 #, Index 7 #, Mark Entry &= &2t |
(Fig 2)

Fig 2

=
Mark

Entr)h

Index

[ Insert Index

Mark Index Entry [ |
Index

Main entry: 'Callisto

Subentry:

Options

Cross-reference: |See

@ Current page
Page range
Bookmark:

Page number format

| Bold
Ralic

This dialog box stays open so that you can mark
multiple index entries.

[ Mark } | Markgll_] I Cancel ]

*  Subentry 3T § AL @Y F TS THA & | AT FATTH
e @e =1fkw | a9 subentry e § colon &T 9@
|

A U ® ufq d@g+ a9 €, Cross-reference under
Options, 9% fFas #1 {2 ara & gaxr Gt F37 & forg
THRC T T F |
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« 39T | U EAT U TE@AT & BTHE A & o7 Bold 3%
aa AT ltalic 9% at#s Page number format & =
& =TT F

4 Mark ¥ s w2 3o U o fafea & & foo |1 o
IR S TrgAe § aft e T AT @ A #A & forg,
Mark All 7X &= #3t |

5 wrfes 2a Ufw &t ATh &9 & forw text 94T, Mark
Index Entry s« ate ® s 7, e 9=on 3 sfiw
4 =t qrEre |

2299 &t 9T (Create the index)

HTTHT Te<T & ATH FIA & 18, AT STHJAC F 399 Hf 369
FA & forw oo AR E |

1 et 29 #t add FAT & foas w40 |

2 Onthe, in the Index I # References tab 9, In-
sert =35 s #2t | (Fig 4)

Tj 1 Insert Index [}

Mark
Entry

Index

3 Index STATT 4199 ¥ 3FE UL wHe FA & forg, o
", S X e aut & 941 | (Fig 5)

Figh - :
Index B8 "5
Index '_ Iange_n'__i_r,\_nuqu_l Table of Figures [ Table of Authorities
Print Pregiew
Aristotle, 2 +  Tpe @ Indented Rup-in
Asteroid belt. See Jupiter Columns: |2 v
Atmosphere
P Language:  English (United States) H
Earth
exosphere, 4
Right align page numbers
Formats: From template H'J
Mark Entry... | | AytoMark.. | | Modify..
oK Cancel

4 = F1 O fR@mEe & aRkady &3+ F g o7 Formats
A et amer #g & & g | faer & S ang 7 fieg
g wefia shm |

5 OK X fFas & |

3T S a1 & ATE WY 3TT SATST USH AT HT, dd 3T

I A & foru, S8 F FU=T FHEAT BN |

1 3 sma XE fields &t & d&@ @%d &, Home tab 9%
Paragraph group # ST Show/Hide ] o= fF®
Eall

2 Ul S A Sgdq ATed & XEfieIdaﬁ%{%’rl { XE
“Callisto” \t “See Moons” }.

3 UF S ULl &I TUTRA AT B F¥A & forg Igrevvr e
% QYT TR & Fadl |

4 o F USE A & forg, Index ¥ faFaw w2t fBT F9
zarert a1 References tab # & 7 & Update Index
7% fFerF F2 | (Fig 6)

Fig 6

+ 0 [ Insert Index
| —
" Update Index

Mark
Entry

Index

= § A T T & for, 29 Ut fora so aRkafda s
HTEd & Sl TaT AT e afRkafda #er Y 299 & saee
HT |

1 sEa/se® ({}), 7Ra W 99 U G & T899 7%,
feefie (DELETE) e gar # |

afy st XE wieew @ 78t adt € at g (Home) 3 &

dTe (Paragraph) 39 & sm#e wifeTze (Show/Hide)

q o s # |

2 39 H AUSC FA & forg, Indexw¥ fFer w1, ¢ F9
zarett a1 References ¢a # 239 g7 § st Update

Index o= f&® #<t | (Fig 7)
Fig7

F [ Insert Index

L1 [ Update Index
Mark

Entry

Index

A&, & wE. A .L.uq. : wur (NSQF @ - 4) - 319+ 1.6.36 177



F - 4 : fatvrer faew / grgaefers AT

AT F W™ W TEIRe® I (Create a hyperlink to a
location on the web)

1 < 77 o B o sEuies S| 9eiE ST "9ed
T |

2 Insert tab &, Hyperlink. | &, | fF=® &2 | e e a1

o =7 Tge fFes Y @ &, Y adwe 7 7= Hyperlink
far® et |

3 Insert Hyperlink ars #, stmast fois &t Address box
H 2T a1 9% #X |
e : s S0 Address box 7 3@ @ ¥ ghafwaa

F¥ #I Existing File at Web Page, under Link &
ERIECRER IR I

Ao, A forw # 3 A fafvrr weffm e aegw
F AT F TG FA & g |

ST SATIHT BTFIR TR FT T ATTHR ATTH A& & Fewae
# Browse the Web |7 URL #t wat %ewt & fF®
2 AT FT FA

AT FFIET W FEA FLA & (N0 FEA (ot TR (Create

a hyperlink to a file on your computer)
AT FFIE § FEAl F & forg hyperlink STret a1 T 74T
FIEA ATTH FFIeT H aq & forg |

1 <o a1 o & g9 S AT ERUcl® | TS HAT Ared
g

2 Insert tab & Hyperlink | &, | o= =21 |

3 Linkto & e, o= & & uws &<

*  TF WISET W15 H fois ®¢ & forg Link to % = Exist-
ing File a1 Web Page f& &t | f%% wrsar & Look
in list a1 Current Folder list & @ttt | (Fig 1)

Fig 1
Iser Hyperink [
Unk to: Text to display: _ s<_mn|'|g |
,é] Look in: Documents vl |
Exiiting Filé e
o Web Page [ Bgokmark... I
Cyrrent L
Foider ! Target Frame.. |
PaceinThis | |
Document Browied
Pages
Create pew Recent
Dotument Files
ul Addigss: | v
E-mail =
Address r y
Cancel |

+  UF AT AT HI3A qATHE JAH fois FA % forw Link to
3fe¥ Create New Document 9% f&T& &<1, 74T %15 %
AT 2TE H, A AT =& & siavid f3=me Full path
START T AT Change f&® 3% gAY e 9T &F ¥
oo #¢ | 3T Edit the new document later & It
a1 Edit the new document now @&t | (Fig 2)

Fig 2
Iser Hyperink [
Link to: Text to display: | - e d
__!] Mame of new document
Existing File
or Web Page
Full path:

CAUsers\Adminkitrator\Documents Change... | Tatget Frame... |

Place in This
Dacument
] When to edit
Create few
Document Edit the new document fater
#) Edit the new document noy
E-mail

Address r r -
| oK Cancel

% T email message ¥ U grzufe TR

1 aFe a1 o #t == w0 SE o sEls S99 gefiia
HYAT =Ted & |

2 Insert tab #, Hyperlink | &, | e &3t 3 a1 f &t

TEe fFa® # fY weae #g 9 Hyperlink fa@s 2|
3 Link to % ==, E-mail Address f&& #2t | (Fig 3)

Fig 3

B

| Sereenmig.. |

Insert Hyperlink
Unk to: Text to display:

iC| E-mail address:
Existing File | |
or Web Page
Subject

Plyce inThis | Regently used e.mail addresies
Document

Create few
Datument

E-mail
Addrets

[ cancel |

4 E-mail address st # 3117 9T dT 2157 0, T Recently
used e-mail addresses fcree & at &t g7 |

5 Subject box &, @391 fawz ey F |

oot : T A9 TowH R email T e @rEw
F g™ Tt g |

6 Ok aeT u¥ fFas =3t |
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TAAT TAET § TF I & o0 Trgafersd aAm=T

1w AT T F gA ST AT STFUR(oE o Wefa FAT
TMEd © |

2 Insert tab #, Hyperlink | &, |.. f&r® #21 | 37 e a

forr &1 wEe fFF #¥ @i wéwe A9 § Hyperlink
FATSAT |

Fig 4
Insert Hyperlink [
Link to: Text to display: ScreenTig...
9 Select a plage in this document:
Existing File Top of the Document
or Web Page
Headings
lomarks
¢ Bk ‘ Target Frame..
Pigce in This S
Document
Create pew
Document
E-mail
Address - -
Cancel |

3 Link to % @, Place in This Document &&= =3 |
(Fig 5)

Fig 5
st Hyperink [ I
Link to: Teat to display: _gc;un-'l';g_ |
-:'] fookin Documents v] I . ':L:;' .
Exiiting File | — -
or Web Page ‘ Bookmark... |
Cytrent : '
Folder | Taget Frame... |
Place in This [
Document Browsed
Pages
Create few Regent
Dotument Files
L Addrgis: | :
E-mail -
Address 5
Cancel

4 fore #, ofid (Rrk adwe sTagHe), gTH, WSS, FeeH
Y, AT B HIW T AT ok FAT AR & | g4 |

5 Ok aeq ¥ fas &< |
3o (Options)

EEURfd U¥ ST AT UTgeX &l ¥T@d &, a9 HEAEA the
ScreenTip f3@rE @t €, Insert Hyperlink 3w ame &
ST arfet &9 § ScreenTip u¥ fas &2t sfiw o ot
TR AT ATed & I F |

AT TTHFIAE | UF BN I FEUR (eI a7
1 e ar o &t g O o ewfed S99t
qrEd & |

2 Insert tab #, Hyperlink| £, | o¥ fF® #21 | 37 doe

X oy 7 TEe fFaw F2 MY wmdae /g & Hyperlink
o) fFos w4 |

3 Link to % for&, Existing File or Web Page. & &=
#% | (Fig 5)

4 Look in ara ®, sig T #t fFw #0 ##X find and
select the file it T foi FeaT 9TEA € |

5 Bookmark T fFs %1, oY, gFATH, W FEEH AT AT
T " St AT ATEA € A AT Y OK e et |

F - 5 : g ATk, RoqofY, afieeor, wE-we gedte ¢ w7

TE ® FHEATHA F SArgar a1 e F== (Add or delete

bookmarks in a Word )

W WX JHEATE w2 (Bookmark the location)

1w ar foF F: AT AT AHT STRgHS H TR TRl AT
TJFATH T FAT TR & |

2 Insert > Bookmark o fa&ts &1 | (Fig 1)

3 Bookmark name # {19, t® 9 e w0 R Add
e wer |

FE.&. & wE.fHr.dug. : Fur (NSQF @2 - 4) - 303919 1.6.36

Fig 1
Home Insert Design
L — I | , == ol
k Page  Table Pictures: ': Online Hyperlink{Bookmark| Cross-
e Break i Video referend
3 Tables i ! Media Links

oot : Uw e @ gEFTE AW gE S ARy | '
T 7L AT HAT AT FY Ahd &, AR GTeAl W
(spaces) TEl | WX ATYHT T AT FIAT ATEA &,
AT TF underscore ( _ ) T TIWT FT T & —
Iq1e¥W & fU First_heading.
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FEFATEH AT X A (Go to the bookmarked location)

Ctrl + G zrz7 #%t Find and Replace box & Go To 2%
@i & forv | Go to what & = Bookmark f&# #3t |
bookmark name dex a1 gt {5 Go To =X fFa® &<t |
(Fig2)

Fig 2

Find and Replace ? X
Find | Replace GoTo

Gotowhatt ~ Enterbookmark name:

Page | |Contoso| =
Section )
Line

Comment

[Footnote 2]

-W‘ Close
gFaTH Ft forF F:2 (Link to a bookmark)

ATT ETFILAF FT SIS Tt & ST ST FETAS H FHATHS &
X & S |

1 RS IT ATesTe &1 FAT HU S ATT SETL el SH T
FHAT =T © |

2 ¥rze fFow fe Hyperlink | € |9 s #20 |

3 Linkto & =, Place in This Document 9% fa® %31 |

4 g # oA v gFATh St e i wear = € g |
AT : A AT FTARFF T¥ TAF 1 3% 34 €, fora
o srgpiem #7 & fo, foem few few =00, e ot
TRE ATTHT ALY LT FIt |

5 OK f&r® &< |

g&ATH fefere #31 (Delete a bookmark)

1 Insert > Bookmark f&r® &< |

2 TEgHC § gHATHE H fore A€ Fe & forg Name ot
location fa® 3T |

3 gEHuTE F A fFw w0 O e fefere wwam wmed € e
delete s #t |

4 R 9 Rfee gaws &t eEwlas w6 e,

forre dare TX Trse A w2 T remove hyperlink @@

|

feoquft : gewTh a1 gEETRT sTEER (G TwE wT E

o A aw) Al w R = F fog, sngew w=@

gat, Y ffer gamen |

uF FHe & e ar fRefere w0 (Insert or delete a
comment)

1 S ®ee I ATHUT ¥ FHAS HAT =Ted al Il T4 4T |

2 Review > Comments > New Comment 9T ST
AT FHE &1 | ST ATIHT FHE | GREAT HLAT e &t
I ST I Garied Her |

3 UE FHC H AT a7 % forg, FHe F SreAt, Reply F1 =7
|

THETT E9¢ #20 (Insert Equations)
1 STt T Hiweer ¢ HAT Jred &t g8t FA¥ w@r |

2 Choose > Insert > Equation f¥ T=t ses 9 faer 1 |
Fig # 3wt itz srgawor &=t | (Fig 3)

Fig 3
D‘I' Signature Line ~ n O
ER Date & Time Erinstion S : I
guation Symbo
[l Object ~ =
s

Built-In

Area of Circle

A=mr?

Binomial Theorem

n

c+a)t= Z (:)x;‘a"'k

k=0

Expansion of a Sum

| nx  nln —1)x?

3 | g&R T FHHI $HE FIAT AR B IR AT BT
fFa® #20 | Fig 4 # gotar & $9e oo fias g |

Fig 4

EQUATION TOOLS
REVIEW VIEW DESIGIN
=|[=][F]||2]]=]]|=]]|Vv J =
—~ =] bl =1 ¥ - 1
\% | | = | 3 | ell> | | T | = Fraction

-

("]
F

4 3T T F EHE FA & a1 Equation Tools Design
R, Teteh ST HCIAT & AT ST SATIHT THEHLT, FY ST
ST T & |

IRV U TR H qHIHTOT 2a¢ %21 (Insert Equation
in normal typed text)

1 = Fig 5 # faar s 2o &t red & |
2 FRE FT AT FA |
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Fig 5 Fig 8
DESIGN PAGE LAYOUT REFEREMNCES MAILINGS %3 HypE‘rIin-k
Body) ~|11 ~| A A |Aav | Q| =iz 0y [ Bookmark
U ~abe x, X° [A~ . - B=== i =
4 k| Cross-reference
Font = Paragr:
e ! Links
=((372)X(473))/2 |
Fig 9
3 A< FT 9O U (BT THAI de e wer | Reference type:
4 T T H NI geT F FAT FA, g YT & Equation Numbered item e
Tools & &= | (Fig 6) Numbered item e
Fig 6 Bookmark
T I Footnote
m H v 0- Document! - Word (Product Activation Failed) EQUATION TOOLS En dn Qtt
FILE HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES  MAILNGS  REVEW  VIEW DESIGN E au atlﬂ!‘l Lo
'.‘I ot (1T o = T = Tl ] mimiEEclE =11 1
T Someset e IR M AP EREEMEM §

s 0 i0j0 DD ol DioiE DSi/=in e

Tagl n Symbols

L | & ! 1 E] 4

= ((312)x@3)2

5 foret Fig 7 4 ferd St awfiereor stdhmreret % faré 2 |

Fig 7

REVIEW VIEW DESIGN

=|[z||F||=2||l=x]||=||V % €

viI3l(3Ilel|all«<||T] Fraction 5c
3 4
(3%)X(4*)

2

afa @asf #t Z8¢ #4 (Insert the cross-reference)
1 STHgHe § IwRe S A7 #aW 9E FAT § T w4 |
2 Insert tab ¥, Cross-reference &= <1 | (Fig 8)

3 Reference type a@ ¥, f1= e amam goT & Ie™0
& o faers #AT = med @ W) s w0 | e §
THY & ATZSH U & AR Fear & | o smgew &t
TH & T fosk # W@ € | (Fig 9)

4 Insert reference to box ¥ SHIHE # ST AR AT
ZHE HEAT ATEA & AU [Fs FU | T 3 H 9 A FAA
& i AT & smasr wd@g 79X | (Fig 10)

Fig 10
Insert reference to:
: —
Heading text |V

Page number
Heading number

Heading number (no context)
{Heading number (full context)
Above/below

5 For which box & fafire srgen @ oo dewt we

Ied & 39 9NE fFsw w0 | s “Insert the cross-
reference.”

6 IUANTHAT I THIE ATEH U 9 w3+ & {17 Insert as
hyperlink == st & === &<t | (Fig 11)

Fig 11

Reference type: Insert peference to:
Heading V| Heading text ot ._
Include above/below
Separate numbers with
For which heading:

Create a cross-reference
Insert a cross-reference
Remove a cross-reference

Insért the cross-reference
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7 ¥ Include above/below 3% atFT Iueier &, A
F TENT Argew F ame forfa f[fde ofre &3 &

oo
8 Insert &1 w7 |

FeAte My dzAte gwé &3 (Insert footnotes and
endnotes)

% % 4 perten fFard awd & i STde F sid # vedten

Ad & | Fedle AT Ul § T AT Tidw SEgHe F Hafid

% & faed € | (Fig 12)

1 Yedle AT UedAte fFeR d@a F¥AT 9=d & 39 9% fFw
Exall

2 References tab ¥, Insert Footnote a7 Insert Endnote
&1 =a= &< | (Fig 13)

3 Tedle AT U Al # AT T ATed & UeX & |

4 TTEgHE | SATTET € 99 T @A & 99 Al & IE |
T 97 i 9¥ g9t foered e |

Fig 12

n The citer Sevice coulld be a Windows tabilet or phane, IPad, iIPhens, of Ancrod tat

Word uses a number or symbol to associate the note
with a reference point in the document.

the text you want. if you need to stop reading before you reach the end, Wo
ieft off - even on anather device

Fig 13

Insert

Design Layout References Mailings

ABI [II‘[_‘,] Insert Endnote ;D @

AB, Next Footnote ~

Insert =] Smart Researcher
Footnote = Show Notes Lookup
Footnotes M Research

FT - 6 : qEAl FAT ATHIO FT A H2t, LT Ft FAqAE FA

1 a% SEgAe 898 ¥ 99 3 9 et |

2 A= o ey e (SEH IR §, 99 et w |
T | oAl & AYEAT AT ATHT oAt e w g |
(T "o & forw a< AT FEAT € gad H HT FAA) |

3 T B & ATE SEGHE F AT FU A @ e ASIATE
AT ATHT TAAT & A AA ASIATEE AT dr qaav
et Fig 18 99 |

Fig1 reference, ete,
Lets try with a footnote*

Lets try to find the grammer and thesaurus options in Word,

This are to find speling errors and grammer mistakes in Word, Try to
find what Word does with error messages.

4 & faker s & forg gfeat siexeng am@iT W) Ee
s 0 Y @& FHLW[adAT F agar 99 Fig 2 §
feamar T E |

5 arr ® UF weE AT, 99 38180 & forw word fRe famer
& find Translate % fore Tge fFo w2t |

6 Fig 3 ¥ 3uIiaT J¥ 9 TS & for sTaTe I fofereh et |

7 A€ AYATE GFA WIOT fIweT & AT TF HAT & A 7T B
AT AT AT F SAFATE FIA F1 AFATT AT & AT AFIETHS
sgaTe fa®eT online &t AT &, AT 3gaTe & forw |

Fig 2
Lets caibrie - 16 ~ A~ o~ i= == er and thes
I UE¥Y-A-J
This _are to rina spenng errors and gra
find Thisis ith error mess
These are
Ignore Once
& Grammar...
AT
Fig 3

res,

AL R

RIGaZ A TR AR e g il
Tarril [=l

Translate the whole
daocurnent,

a

# Microsoft® Translator

l::-ls Options in iw’mﬂ. Translation options... -

er mistakes in Word. Try to

Moo=

5% Translator

Get more languages
Microsoft® Translator
| | & Can't find it?
Try ane of these akternatives |
o see Help for hints on - |

!

8 arfe fawet & forw s srgewe & R A |
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A & s Aima. (IT & ITES)
w1 (COPA) - ¢ safi stweae

v e 1.6.37

GAT T U S[EY I Xk g & w=™ = (Typing practice using open

source typing Tutor)

IR T AWM & o § AT FIA H q6H 81 G

o AT T ST STEX ATIANT T TESAAE R I H2A

o T[T FT T FIAT |

smawwae (Requirements)

AT [SYHTOT[ATEA

o favgim OS uwd MS wifew 2007 & a1 us =ferd PC -1 No.

s (PROCEDURE)

FF - 1 : GoAT T ST TEX AUTTHTA F TSN T FRT FA |

Fig 1
typing tutor download

Google

AN

{ -
7

1 TR 9 § "Typing tutor download" /=T &<t |

2 "Google Search" f&= w41 |

https://typingmaster.en.softonic.com/redirect-download
T

https://sourceforge.net/projects/typefaster/
?source=typ_redirect

T

FEF - 2 : ST FT =T W

ITART FIA H AW AR qh A

TIPP10 is a free 10-finger touch typing tutor. You can use
TIPP10 directly in your browser or you can download the
software version for Windows, Mac OS and Linux. TIPP10
is easy to use and features a clear user interface. Begin-
ners will find their way around right away so they can
start practicing without a hitch. You will be able to learn
touch typing quickly and efficiently with the program's in-
telligent practice lessons, useful support functions and
an extensive progress tracker. You can also play a typing
game and expand the program with open lessons or make
your own to meet your specific needs. (Fig 1)

TS AT GAT FATA TTFT ST AAAHIT & FART F

&l i wHe &1 wwE w49 (Practice the proper
typing format)

g i Teret |
ST FEHAT FATEAT |

farfsrer wrete ersfiaT #T 31T oTaT STgReTs & gerEar & o R
IoTH F |

Fig 1

% Cokred frrs
irer el W Home Fiam

X Moten Bat

LR Separaton Lne

N eamacton
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2 Intelligent text selection

The lesson texts react instantly to your typing mistakes
by repeating mistyped letters more frequently. The sys-
tem helps you eliminate typing mistakes and learn touch
typing efficiently. Awide range of dictations ensures you'll
never get bored. You will become acquainted with all the
keys on the keyboard in 20 sequential practice lessons.
Commonly used characters are practiced earlier and more
frequently than those that appear less frequently. (Fig 2)

Fig 2
J PR L]
Learn touch typing for freef]
1 @ [ * &) ~ -3 { ] e + .
1 2 3 1 5 f 7 8 aq n -
"~ | wl e el =l 2ol 204 13
A 5 o P G H 3 K L .
2 | xS J ¥ 8 l TR R s e b
= H  a an [
Exie Lesson eaely Help Pausme:
Checking typing speed

1 Detailed results (Fig 3)

Fig 3

7 =E

Croerview of Lesmom | Progress of Lessons. | Characters | Fingess | Comparison Tabie

Error rates of your fingers

(AT

The mrir rabe @ bases on he recorded charsciers and e carmen semcied Leyboand leysst

i

[ o

After each typing lesson you will receive a printable com-
prehensive report that evaluates the lesson. A list of all
completed lessons including details about duration, num-
ber of errors, characters per minute and an evaluation pro-
vide you with an overview of the work you have done. A
lesson trend diagram shows your progress and allows you

to easily compare your results. TIPP10 also shows you
your error rate for all the characters and fingers used in
the typing lessons. This way you can see right away which
keys and which fingers you still need to work on.

2 Open lessons and create your own texts (Fig 4)

Fig 4

| Create own Lesson [

Hame of the lesson Ji
Laample

Every Ine (séparsted by Enter kev)
5 euivalent 1o & unit of the lesson,
shart descrinSon (120 charscters maic); Thene are twg Types of lesson
Short example lesson i

Senbenoe Lessan - every ine
{remlerae] wil be chekated exactly
hore # waas entered here with a e
trmak ot the end.

Liegson coritant (at kenst two bnes):

This & & short example,
1¥'s wary sy to creste an gwn kesson,
Frst

Word Lesson - the ines vl be
separsted by blarks and & kne break
Dasses suomatcaly after atleast 35
characters,

What happens when

"Il " is enabled?

With enalied nteligerce, the e 1o
be detated wil be selected
dependng on the typing mestake
Guotes Fstesd of dctating hem m
the right srder. Enabiing the
“Tneefigene” oniy makes sere iF the
Iesan corvsts of many bnes {ofien

Dictabe He beat su “Winrd Lessons ],
& Serience Lesson Word Lesson
Carerl Mo [ swe |
3 Extensive customization
Fig 5
| General Settings @
Ticker
Font: Font Color:  Background: Cursor:
i ) 0
II'E'E' Speed:
off § Fast

Language

Larafien]

Results ® Sound Card
PC Speaker

Audio Dutput

Metronome: \EU cD[Lli!

Cancel Help

Save

You can choose how the lesson will run. You can set the
duration of the lesson, how the typing tutor reacts to typ-
ing mistakes and which visual aids will support you during
the lesson. In general settings you can also personalize
the software even more. Here, for example, you can se-
lect a different speed for the ticker or a larger typeface
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e A, & sEAzaa. (IT & ITES) s 1.6.38
w1 (COPA) - 7 SR aiwed

A AT Td 9 MEAY | ITIHT 2+ aret weswe ot (Shortcut keys for open office
and word processor)

IR T AWM & o § AT FIA H q6H 81 G

o q¢ TFTAT N ATEHE HIAAT HT 30 |
ATGHATR a8 | g a1 & ol adswe #i
CTRL+SHFT+SPACEBAR TSR TG FATAT
CTRL+SHFT+HYPHEN At T &1 sATAT (Create a nonbreaking hyphen)
CTRL+B A H e HAT (Make letters bold)
CTRLH T it geford weAT (Make letters italic)
CTRL+U T AT eTaTsA HAT (Make letters underline)
CTRL+SHFT+< T A9 & Hive FT ATHE F7 w47 (Decrease font size one value)
CTRL+SHFT+> TF HIF ¥ Rive & AR 98T (Increase font size one value)
CTRL+| ®ive HT ATHIT 1 TEe & 9 F¢47 (Decrease font size 1 point)
CTRL+] ®ive HT ATHT 1 5 & F@™T (Increase font size 1 point)
CTRL+SPACEBAR ST AT FFeY WH T 2T (Remove paragraph or character formatting)
CTRL+C TofAa 3 AT AteiFe it Har w1 (Copy the selected text or object)
CTRL+X FIAT TR AT Atetae H FHe FAT (Cut the selected text or object)
CTRL+V R AT Ateiae & T FLAT (Paste text or object)
CTRL+ALT+V owe @t (Paste special)
CTRL+SHFT+V ford aiwfer aee w1 (Paste formatting only)
CTRL+Z Tt T &g &A1 (Undo the last action)
CTRL+Y st e g AT (Redo the last action)
CTRL+SHFT+G I FHTIE TFANT arad @redr (Open the Word Count dialog box)
e, = ST &9 SEgA=a (STHIHE Ft TAET, AT AT AT FAT)
CTRL+N 79T SagHe @reT (Create a new document)
CTRL+O F3 StagHe et (T8 & W) (Open a document)
CTRL+W gfagHe d5 AT (Close a document)
ALT+CTRL+S gtagde favet fasfor waT (Split the document window)
ALT+SHFT+C orALT+CTRL+S Aot &t =e™T (Remove the document window split)
CTRL+S glagdw 89 347 (Save a document)
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Tz, e @ aew g 3w

CTRL+F Ao e o9 Gt (ST a9 #A & ford)
ALT+CTRL+Y FIEE H ST (FE<e & Retw favet g7 #34 # a9).
CTRL+H e geanT, fafire s wear ua famy agg
CTRL+G O, IFATE, FeAle, T, T, AT(haq AT AL & IX AT
ALT+CTRL+Z ST eTfedt A e A@mited fF € 3% 9 § e wwn
ALT+CTRL+HOME TS (Aot & goi AT | Fig Aher A & ford O & @, Fata faweT
FT IJTART FF SAIAC A AT HEAT
CTRL+PAGE UP o aew i g8 setae W™ 9
CTRL+PAGE DOWN A FISA [ g ATeiFe T A
TR F A " w0 (TR F A A=)
ALT+CTRL+P e & siee g # e w3
ALT+CTRL+O TIedTEd F | e FeAr
ALT+CTRL+N g o | fea A
SeaTE A (T)
ALT+SHFT+LEFT ARROW SRR T HIAT
ALT+SHFT+RIGHT ARROW T fEdte SAr
CTRL+SHFT+N FIST ST TF AT FLAT
ALT+SHFT+UP ARROW AT GITE T FIC & AT
ALT+SHFT+DOWN ARROW FAAT IATE B A= o AT
ALT+SHFT+PLUS SIGN 2T F SfeT o aTet dFe &A@l
ALT+SHFT+MINUS SIGN farett 2fST & sfew & e &t dfe... Fw
ALT+SHFT+A AW TR AT fST &t ggmT ar feEr
ALT+SHFT+L FIET THRT & TEAT ATZA AT [T AleT e feamr
ALT+SHFT+1 i 1 wrEe # an efew feamn
ALT+SHFT+n 2T n aw Ay 2w fammr
CTRL+TAB T Fae STAAT
TEGHT F N FE e Fw0
CTRL+P Stagawe e Fear
ALT+CTRL+ e foeg ox e #3r
Arrow keys S W g A g a7 ey o # g wAr
PAGE UP or PAGE DOWN S A S FAT B at uF fieg O Fu AW
CTRL+HOME Ted e 9 9% ST (99 7 se e a)
CTRL+END sifow fireg o1 9= ST (F@ @ ase R )
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Strge Rag (Feftear) w2

ALT+CTRL+M FHe (feuroft) stemT
CTRL+SHFT+E a9 gfdT wt ST AT AT FLAT
ALT+SHFT+C afs Regdr 97 gorr & at 3§ 48 wAr
oot = AR (v7) 37
HOME Tl & JETd § ST
END SERIAT & 3d # AT
n, ENTER g% N 9 ST
ESC AT deT9e F & aTeT AT
Revw, gewien v deien

ALT+SHFT+O 3T ATE Fee AT UL H ATH FAT
ALT+SHFT+ T ATH SATARIST F1 Tl Ft 7415 FeAr (Frewm).
ALT+SHFT+X 389 UG AT AT
ALT+CTRL+F g 58S HTAT
ALT+CTRL+D TgHTe §E HIAT

T st % @ A ()
LEFTARROW TF HFe qEl A A F ford
RIGHT ARROW T F TF FAET (AeT) A F oy
CTRL+LEFTARROW g & UF 9= S & o
CTRL+RIGHTARROW IE H TH TS T & ford
CTRL+UP ARROW TF GITE FAC A1 & forr
CTRL+DOWNARROW TF ITE A S & o
SHFT+TAB e ® TF 8 ar AT A & ford
TAB e § UF 8 Al T oW & ford
UP ARROW T ATET FIX
DOWN ARROW TF ATIT A
END AT & 3 &
HOME ATEA & AT A
ALT+CTRL+PAGE UP favet fa gpeema &
ALT+CTRL+PAGE DOWN favet & sfa &
PAGE UP TF T FHIT (TRITenT)
PAGE DOWN TF T A (SR
CTRL+PAGE DOWN A IS F FAL AW & ford
CTRL+PAGE UP frod g8 % I W & o
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9 STRIAT A I FAT (AT

CTRL+END foreY Stagi= & ofd & oW & ford
CTRL+HOME foreft Strpive 1 e & T ¥ forr
SHFT+F5 froa e (Rfasm) & o
SHFT+F5 SERIAT @A & a8, TG A9 STagA< H AT a 38 T o1 d9 39
qHT T | e T w1 W W F q.f I & o
A | A FLAT
TAB T H 3T FA W AW & ford
SHFT+TAB T F fUed 8d W 9= & o
ALT+HOME T H e 8 § A & ford
ALT+END T F sifqw &t & o & o
ALT+PAGE UP HAH | I8l A § ST & fordr
ALT+PAGE DOWN | | sifow @ & 9 & o
UP ARROW et o & o
DOWN ARROW AT O & forar
ALT+SHFT+UP ARROW T 5T
ALT+SHFT+DOWN ARROW T TRA
g H UIONE T T FFEH LA

ENTER qA | AT GLATE STAAT
CTRL+TAB A # 3T HFed STAAT

HIRIST & HGT FLAT
CTRL+SHFT+C A T RIS BT HLAT
CTRL+SHFT+V T IT HAY AT AT BRI TATE FIAT

i F TIAAT AT IHHT ATHR TGAAT

CTRL+SHFT+F ®Ive FIA & ford Bive STAANT T e
CTRL+SHFT+> I FT ATHT TS
CTRL+SHFT+< ®Ive & ATHT TSHT
CTRL+] EIT FT ATHT 1 5 & T@TAT
CTRL+| Hive HT ATHN 1 TES & TS
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HETA F EHS F TG T

CTRL+D FACT HT BIHIT Tqe & fordl Bive SEATT q1 GreAT
SHFT+F3 I T H FFAT
CTRL+SHFT+A AT &I HF HfUed § TaeT
CTRL+B AR AeH & dieg HLAT
CTRL+U HEXATE AR FLAT
CTRL+SHFT+W &L i SASTATEA FIAT &H A2
CTRL+SHFT+D TS FT TAA HSTATEA FHLAT
CTRL+SHFT+H F< e (gft g%) TRe BfET any FwAT
CTRL+ geford wfeT T FAr
CTRL+SHFT+K A & SIS HfUeed § BHE HIAT
CTRL+EQUAL SIGN FHEFE RS AT FIAT
CTRL+SHFT+PLUS SIGN gafere wHfeET am] F#eAr
CTRL+SPACEBAR ATAT FIFEL BIRIST & ST
CTRL+SHFT+Q == &t fowaer wie § ageEr

g WEE (SgAt F S W ) AT FA
CTRL+1 wFe (fiver) amg =T A Fwr
CTRL+2 el (Taw) wTgT W AT FTAT
CTRL+5 1.5 TS W Fe FEAT

CTRL+0 (zero)

Rl 9NTTE F Y UF AT F TF H SAIeAT AT ST

IIENE AATEA FEAT (HRaa F:E0)
CTRL+E et sTg=ST #t 7 SR a9 uATse & dr R wr
CTRL+J el =T (AXTITH) AT STEEEIES A A F A e Fe
CTRL+R et T T I AT MY AR AAEE F A9 fFrT A
CTRL+L URTITH & AFE AT HEAT
CTRL+M arft AR & I ¥ AT
CTRL+SHFT+M A & T €2 geT
CTRL+T BT €82 aam
CTRL+SHFT+T BRIT €8 7 FTAT
CTRL+Q IRTITE HIATST T
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